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Inleiding 

Hartelijk dank voor het kiezen van de Noxturnal® toepassingssoftware. De Noxturnal-software is een modern 

slaapdiagnostieksoftwareplatform bedoeld voor gebruiksgemak en een efficiënte bediening. De Noxturnal-

software is een essentieel onderdeel van de Nox Sleep Assessment Systems (Nox-slaapbeoordelingssystemen). 

De belangrijkste functie ervan is het werken met fysiologische signalen die worden geregistreerd/ontvangen 

met behulp van apparaten van Nox Medical (zie het hoofdstuk Ondersteunde apparatuur) en de eraan 

gekoppelde apparaten en accessoires. Het neemt de gebruiker mee door de werkstroom van het configureren 

van registraties, het downloaden van gegevens, analyseren en rapporteren.  

Beoogd gebruik 

Het Nox-slaapsysteem wordt gebruikt als hulpmiddel voor de diagnose van verschillende slaapstoornissen en 
voor de beoordeling van slaap. 

Het Nox-slaapsysteem wordt gebruikt voor het meten, registreren, weergeven, ordenen, analyseren, 
samenvatten en ophalen van fysiologische parameters tijdens de slaap en het wakker zijn van patiënten ouder 
van 2 jaar en ouder.  

Met het Nox-slaapsysteem kan de gebruiker de complexiteit van het onderzoek bepalen door te variëren met 
het aantal en het type te meten fysiologische signalen. 

Met het Nox-slaapsysteem kunnen gebruikersrapporten/voorgedefinieerde rapporten worden gegenereerd op 
basis van de gegevens van de betrokkene. 

De gebruikers van het Nox-slaapsysteem zijn medische professionals die zijn getraind in ziekenhuis-/klinische 
procedures, fysiologische monitoring van mensen of onderzoek naar slaapstoornissen. 

De beoogde omgevingen zijn ziekenhuizen, instellingen, slaapcentra, slaapklinieken en andere 
testomgevingen, waaronder de woonomgeving van de patiënt. 

Contra-indicaties 

Het Nox-slaapsysteem geeft geen alarmen af en is niet bedoeld voor continue monitoring wanneer storing kan 
leiden tot letsel of overlijden van de patiënt. 

Reikwijdte 

In deze handleiding wordt het gebruik van de Noxturnal-software beschreven. Het gebruik van de Nox-

apparaten en de bijbehorende accessoires die nodig zijn voor de registratie van fysiologische signalen worden 

beschreven in: 

● Handleiding Nox A1 

● Handleiding Nox A1s 

● Handleiding Nox C1 

● Handleiding Nox T3 

● Handleiding Nox T3s 

 

Deze handleiding bevat ook een korte inleiding over de Noxturnal-app en haar functies.  
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Waarschuwingen en aanwijzingen voor gebruik  

 Waarschuwing: De Nox-slaapbeoordelingssystemen zijn NIET GECERTIFICEERD VOOR 

GEBRUIK VOOR CONTINUE MONITORING wanneer storing kan leiden tot letsel of 

overlijden van de patiënt. 

 Waarschuwing: De Nox-slaapbeoordelingssystemen zijn bedoeld als hulpmiddel bij de 

diagnose van slaapstoornissen. De systemen moeten worden gebruikt in combinatie met 

andere methoden voor de beoordeling van klinische tekenen en symptomen. 

 NB: Automatische analyse kan minder nauwkeurig zijn dan analyse uitgevoerd door een 

opgeleide arts. Voordat een diagnose wordt gesteld moet het resultaat van de 

automatische analyse/scoretoekenning altijd handmatig door een opgeleide arts worden 

geverifieerd. 

 Waarschuwing: Afgeleide signalen die door Noxturnal zijn berekend, met name hartslag 

en ademhalingsfrequentie, op basis van de onderliggende elektrocardiogram (ECG) en 

ademhalingsinspanningssignalen, zijn niet gevalideerd voor patiënten met diafragma-

pacing/frenische-zenuwstimulators. 

 Waarschuwing: De Nox A1-, A1s-, T3- en T3s-recorders mogen onder geen beding op de 

USB-poort van de pc worden aangesloten terwijl de patiënt nog op de recorder is 

aangesloten. Dit kan leiden tot een elektrische schok bij de patiënt en ernstig letsel 

veroorzaken. 

 

 Lees deze handleiding voorafgaand aan gebruik zeer goed door, en in het 

bijzonder de paragrafen voorzien van een uitroepteken. 
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Beschrijving van Noxturnal  

De Noxturnal-software werkt met de Nox-registratieapparaten en Nox-toegangspunten. Met de software 

kunnen de apparaten worden geconfigureerd en daarnaast kan het de signalen die worden 

geregistreerd/ontvangen door de Nox-apparaten weergeven, navigeren, organiseren, analyseren, rapporteren, 

archiveren en ophalen. Dit hoofdstuk beschrijft de belangrijkste kenmerken van de toepassing en de 

installatieinstructies. 

Beschrijving Noxturnal-app 

De Noxturnal-app is een Android-applicatie die wordt gebruikt als een mobiele interface voor de Nox A1-
recorders en de Nox C1-toegangspunten. Met de app kan de gebruiker verschillende taken die al bekend zijn in 
de Noxturnal-software flexibeler en dichter bij de patiënt uitvoeren.  
De app bevat de volgende functies: 

 
● Ambulante registraties configureren 
● Verbinden met onlinekamers die in Noxturnal 

zijn geconfigureerd 
● De signaalkwaliteit beoordelen 
● Een impedantiecontrole uitvoeren 
● Biokalibratie uitvoeren 
● Registraties starten en stoppen 
● De status van onlineregistraties bekijken 

(Recording, Standby, Not Prepared 
(registreren, standby en niet voorbereid))  

 

Scan om de app te downloaden de QR-code hierboven of zoek op "Noxturnal" in de Google Play Store. De app 

draait op mobiele apparaten met Android 4.3 of hoger. 

Ondersteunde apparaten 

Noxturnal ondersteunt de volgende Nox-apparaten en de bijbehorende apparatuur en accessoires: 

● Nox A1-recorder 

● Nox A1s-recorder 

● Nox C1-toegangspunt 

● Nox T3-recorder 

● Nox T3s-recorder 

In deze handleiding wordt de term Nox-recorder gebruikt als verzamelnaam voor de Nox A1-, Nox A1s-, Nox 

T3- en Nox T3s-recorders. 

Verder wordt in deze handleiding de term Nox T3-recorders gebruikt als verzamelnaam voor de Nox T3-

recorder en Nox T3s-recorder. De term Nox A1-recorders wordt gebruikt als verzamelnaam voor de Nox A1-

recorder en Nox A1s-recorder. 

Installatie van Noxturnal  

Bestudeer voorafgaand aan de installatie van de Noxturnal-software de systeemeisen voor het uitvoeren van 

de softwaretoepassing. 
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Systeemeisen voor Noxturnal 

 

 NB: De gebruikte computer moet in overeenstemming zijn met de 

internationale norm IEC 60950-1 voor de veiligheid van 

informatietechnologieapparatuur. 

 NB: Er wordt aanbevolen om een virusbescherming te installeren op de 

computer waarop Noxturnal wordt uitgevoerd. 

De volgende tabel toont de minimum hardware-eisen voor effectieve installatie en gebruik van de software. 

Minimum systeemeisen 

Type hardware Minimum eisen 

Besturingssysteem Windows 10 

Processor Op x64 gebaseerde Intel of 

AMD 

Processorkloksnelheid 1,7 GHz of sneller 

Geheugen 2 GB of meer 

Vrije ruimte op de harde 

schijf 

4 GB of meer 

Grafische resolutie 1024x768 of hoger 

Voor online systeeminstallatie gelden dezelfde minimum systeemeisen als hierboven genoemd. Het wordt met 

klem aanbevolen om voor elk onlinesysteem een andere computer te gebruiken. Voor ervaren gebruikers is 

het echter mogelijk om meer dan één systeem op dezelfde computer uit te voeren. 

Het wordt aanbevolen om goede IT-praktijken te implementeren, zoals: 

● Beheer de toegang tot de pc waarop het systeem draait 

● Dwing een wachtwoordbeleid af 

● Houd het besturingssysteem van de pc up-to-date 

● Volg de data voor het einde van de ondersteuning van Microsoft Windows 

● Installeer antivirussoftware 

● Beperk het gebruik van de pc alleen voor klinisch gebruik 

● Back-uplocatie van opnamegegevens - Noxturnal zorgt niet voor back-ups van gegevens 

NB: Bij verbindingen met externe systemen zoals Nox Cloud, GDT of HL7, fungeert Noxturnal als client waarbij 

op de bestaande systeeminstallatie wordt vertrouwd als beveiliging. 

Installatie-instructies 

● Zorg dat u met beheerdersprivileges bent ingelogd in het systeem. 

● Blader naar een bestand op de installatie-cd of de installatiewebsite met de naam Setup.exe en voer 

het uit. 

● Een wizard wordt geopend die de gebruiker door de installatie leidt. Volg de instructies voor het 

installeren van de toepassing. Als u een upgrade uitvoert vanuit Noxturnal 5.x, draait op de 
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achtergrond een upgradeproces. Het upgraden van de gebruikerstoepassingsinstellingen. 

Voorafgaand aan de upgrade is een kopie van de instellingen opgeslagen in "[My 

Documents]\NoxturnalUpgrade".    

 

 

 

 Neem voor informatie over de nieuwste softwareversie en upgrade-informatie 

contact op met uw distributeur. Ga voor distributeursinformatie naar: 

www.noxmedical.com. 

 Neem voor operationele ondersteuning in het geval van gebruikersfouten, 

cybersecurity-incidenten of andere voorvallen contact op met 

support@noxmedical.com. 
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Standaardbediening 

Om de Noxturnal-toepassing uit te voeren, dubbelklikt u op het desktoppictogram of klikt u op het pictogram 

van de toepassing in het Windows-startmenu. Om de toepassing af te sluiten, klikt u op de X in de 

rechterbovenhoek of kiest u Exit (Afsluiten) in het menu File (Bestand). 

Als Noxturnal opstart, wordt de werkruimteomgeving weergegeven. Als u een apparaat hebt aangesloten, ziet 

u het in de afbeelding, anders wordt geen apparaat weergegeven. Voor dit document hebben we een Nox T3-

recorder aangesloten, zoals in de afbeelding te zien is. 

 

Op de pagina Recording (Registratie) werkt de gebruiker met Nox-apparaten en de gegevens die door deze 

apparaten zijn geregistreerd/ontvangen. Deze pagina leidt de gebruiker door de meest gangbare taken die in 

de toepassing kunnen worden uitgevoerd. Dit zijn: 

● Library (Bibliotheek): Deze optie ziet u in de linkerbovenhoek. Deze optie opent de 

registratiebibliotheek. De bibliotheek bevat een lijst van alle registraties die zijn vastgelegd, 

gedownload of handmatig toegevoegd aan de registratiebibliotheek. Zie voor meer informatie de 

paragraaf De registratiebibliotheek. 

● Configure Device (Apparaat configureren): selecteer deze optie om een nieuwe ambulante registratie 

te starten. Een configuratiewizard leidt de gebruiker door het configuratieproces. Zie voor meer 

informatie de paragraaf Een nieuwe ambulante registratie starten. 

● Download Recording (Registratie downloaden): Als een registratieapparaat is aangesloten dat een 

registratie bevat, kan de gebruiker de registratie downloaden en beoordelen. Zie voor meer 

informatie de paragraaf Een ambulante registratie downloaden van een Nox-registratieapparaat.  

Om een onlineregistratie te configureren, moet een onlinekamer worden voorgeconfigureerd en zal deze 

worden weergegeven op de Registratiepagina en selecteerbaar zijn. Zie voor instructies over het configureren 

van een onlineregistratie de paragraaf Instellen van het Nox-slaapsysteem voor onlineregistraties.  
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Een Nox-registratieapparaat op Noxturnal aansluiten  

 

 NB: Hoewel wordt aanbevolen om het registratieapparaat via Eject (Uitwerpen) 

te ontkoppelen kan het ook zonder Eject van de computer worden ontkoppeld. 

Noxturnal wordt gebruikt voor het configureren en downloaden van geregistreerde data van Nox 

registratieapparaten. Om te werken met een registratieapparaat begint u door het aan te sluiten op de 

computer met behulp van een USB-kabel. Noxturnal detecteert automatisch het apparaat en geeft informatie 

weer over het apparaat. Detectie kan 2 tot 4 seconden duren. 

Wanneer Noxturnal het aangesloten apparaat detecteert, wordt de volgende informatie over het apparaat 

weergegeven: recording status (registratiestatus), firmware version (firmwareversie) en device name 

(apparaatnaam).  

De op het registratieapparaat uitgevoerde taken zijn afhankelijk van de status van het apparaat, die als volgt 

kan zijn: 

● Empty (Leeg) - Het apparaat is niet geconfigureerd en bevat geen registraties. Klik op Configure 

Device (Apparaat configureren) om het apparaat te configureren voor een nieuwe registratie. Houd er 

rekening mee dat bestaande registraties van het apparaat worden verwijderd als het apparaat wordt 

geconfigureerd. 

● Ready to Record (Gereed voor registratie) - Het apparaat is geconfigureerd maar bevat geen 

registraties. Vanaf dit punt kan de gebruiker het apparaat ontkoppelen en het registratieproces 

starten. 

● Ready to Download (Gereed voor downloaden) - Het apparaat bevat een registratie die nog niet naar 

de computer is gedownload. Klik op de knop Download Recording (Registratie downloaden) om de 

registratie naar de computer te downloaden. 

● Download Complete (Downloaden voltooid) - Het apparaat bevat een registratie die al is gedownload 

en al aan de registratiebibliotheek is toegevoegd. Op dit punt kan de gebruiker klikken op Configure 

Device (Apparaat configureren) om het apparaat te configureren voor een andere registratie of 

klikken op Download Recording (Registratie downloaden) om de registratie opnieuw te downloaden. 

Als u klaar bent met het werken met het apparaat klikt u op de koppeling Eject (Uitwerpen) en ontkoppelt u 

het apparaat van de computer. 

De firmware van het registratieapparaat upgraden 

 

 NB: Nadat u op de notificatie "Upgrade firmware" hebt geklikt, moet u het 

registratieapparaat van de computer ontkoppelen en weer opnieuw aansluiten. 

De upgrade van de firmware van het apparaat vindt dan plaats. 

 NB: Het wordt altijd aanbevolen om de firmware-upgrade uit te voeren, om er 

zeker van te zijn dat de Nox-recorder op de meest recente firmwareversie 

draait. Nieuwe firmwareversies kunnen belangrijke updates bevatten voor het 

functioneren van de recorder.  
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Als er een nieuwe firmwareversie voor het apparaat beschikbaar is, zal Noxturnal de gebruiker hiervan op de 

hoogte stellen. Dit gebeurt apparaatonafhankelijk en u ziet het type apparaat op deze pagina, afhankelijk van 

welk apparaat u hebt aangesloten. In deze afbeelding hebben we een Nox T3-recorder aangesloten. 

 

Kies ervoor om deze melding te negeren en door te gaan met werken of om de apparaatfirmware te upgraden. 

Dit laatste wordt altijd aanbevolen. Om de upgrade uit te voeren, klikt u op New firmware available en volgt u 

de getoonde instructies op. 

Starten van een nieuwe ambulante registratie.  

Om een registratieapparaat gereed te maken voor een nieuwe registratie start u de Noxturnal-toepassing en 

sluit u het apparaat met een USB-kabel aan op de computer. Noxturnal detecteert automatisch het apparaat 

en geeft de gegevens ervan weer op de pagina Recording (Registratie). Klik op de knop Configure Device 

(Apparaat configureren) op de pagina Recording (Registratie). Een wizard wordt geopend die de gebruiker 

begeleidt bij het configuratieproces van het apparaat. 

De configuratiewizard is apparaatafhankelijk. Dit betekent dat de configuratiewizard varieert afhankelijk van 

het type Nox-registratieapparaat dat wordt geconfigureerd. De belangrijkste stappen zijn echter altijd 

hetzelfde: 

1. Configuratie van het apparaat. Waar u het Recording Type (Registratietype) kiest (hulpapparatuur die 

kan worden aangesloten en te registreren kanalen). 

2. Schedule Recording (Registratie plannen), waar u de tijd en datum kunt selecteren voor het opstarten 

van een registratie of waar een patiënt de registratie zelf kan starten. 

3. Patient Information (Patiëntinformatie), waar u de noodzakelijke patiëntinformatie voor de 

registratie toevoegt. 

Deze handleiding toont de configuratiewizard voor de Nox T3-recorder. De eerste stap is definiëren welk 

registratietype voor de registratie moet worden gebruikt. De registratietypen hebben beschrijvende namen die 

aanduiden voor welke registraties ze worden gebruikt. 

Zie de paragrafen Registratietypen en Apparaatprofielen voor meer informatie over het aanmaken en 

bewerken van registratietypen en apparaatprofielen. 
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Als uw registratietype is ingesteld voor het registreren van gegevens van een Bluetooth-hulpapparaat, bijv. een 

pulsoximeter, zult u dat in de configuratiewizard zien. Om een Bluetooth-hulpapparaat te kunnen gebruiken, 

moet dit apparaat gekoppeld worden aan het Nox-registratieapparaat. Voer de juiste Bluetooth apparaat-

pincode/het juiste BDA-nummer (Bluetooth Device Address-nummer) in het betreffende veld in de 

configuratiewizard in.  

Voor sommige apparaten is het nodig om het apparaat te koppelen aan de gebruikte oximeter. Na het 

invoeren van het BDA-nummer van de oximeter, klikt u op de knop Pair with Oximeter (Koppelen met 

oximeter) en wacht u op het antwoord. Om deze stap uit te kunnen voeren, moet de oximeter worden 

ingeschakeld door de knop van de oximeter in te drukken. Volg de instructies op het scherm op.  

Klik op Next (Volgende) om verder te gaan naar stap twee, waar u de registratietijd plant. 
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● Als de optie By Connecting Nox RIP Belts (Start on Belt) (Registratie starten door aansluiting Nox RIP-

banden) aangevinkt staat, start de registratie wanneer de gebruiker de Nox RIP-banden aansluit op 

het Nox-registratieapparaat. Bij deze optie is de duur Unspecified (Onbepaald), aangezien de 

registratie stopt wanneer de band van de recorder wordt losgehaald. Deze functionaliteit is alleen 

beschikbaar voor Nox T3s- en A1s-apparaten met firmware 3.1.0 of nieuwer. 

● Als de optie By Pressing button (Manual) (Registratie starten door indrukken knop (handmatig)) 

aangevinkt staat, is de gebruiker verantwoordelijk voor het starten/stoppen van de registratie van het 

Nox-registratieapparaat. Dit wordt gedaan door de Push knop op het apparaat ingedrukt te houden 

tot het scherm van het apparaat aangeeft dat de registratie is gestart. 

● Vink de At Scheduled Date (Geplande start): optie aan om een specifieke registratiemoment in te 

plannen. Het apparaat schakelt zichzelf op de aangegeven tijd automatisch in en begint met 

registreren. Als de gebruiker ervoor kiest meer dan één nacht te registreren zal de registratie elke 

nacht om dezelfde tijd beginnen. 

● Om na een specifieke duur te stoppen met registreren, specificeert u de Duration (Duur) als: 7 uur, 8 

uur, 10 uur of u voert een aangepaste duur in. Als er voor Unspecified (Onbepaald) wordt gekozen is 

de gebruiker verantwoordelijk voor het stoppen van de registratie. Dit wordt gedaan door de Push 

knop op het apparaat ingedrukt te houden tot het scherm van het apparaat aangeeft dat de 

registratie is gestopt. 

Klik op Next (Volgende) om door te gaan naar de derde stap, het patiëntinformatiedialoogvenster. In dit 

dialoogvenster kan uitgebreide informatie over de patiënt worden ingevoerd. Het enige vereiste veld is de 

patiëntnaam of het patiënt-id.  
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Nadat u de patiënteninformatie hebt ingevoerd, klikt u op Finish (Voltooien) om de configuratie weg te 

schrijven naar het apparaat.  

Als er een registratie op het apparaat staat, wordt de gebruiker gevraagd of hij/zij de registratie van het 

apparaat wil wissen. 
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Ten slotte wordt een bevestigingspagina weergegeven ter bevestiging dat het apparaat is geconfigureerd. Voor 

Nox T3-recorders kunnen de aansluitinstructies worden afgedrukt door te klikken op de knop Print Hookup 

Instructions (Aansluitinstructies afdrukken). Een PDF-document met het aansluitdiagram wordt gegenereerd 

en kan worden afgedrukt. Als er geen aansluitinstructies beschikbaar zijn, wordt deze optie niet weergegeven. 

   

Registratietypen 

Noxturnal biedt een reeks registratietypen voor het configureren van zowel ambulante als onlineregistraties. 

De registratietypen omvatten de apparaatcombinaties die worden gebruikt voor verschillende typen 

onderzoeken en de apparaatinstellingen. De registratietypen definiëren ook de automatisering voor de 

verschillende registraties, de relevante werkruimtelayout, analyse en rapportage die voor de registratie 

worden gebruikt. In Noxturnal kunt u gemakkelijk uw eigen registratietypen aanmaken om apparaten aan te 

sturen en de voor registraties gebruikte instellingen te regelen. Volg deze stappen om uw eigen registratietype 

aan te maken.  

1. Selecteer het Nox-registratieapparaat waarvoor u het registratietype aanmaakt en geef aan of dit is 

bestemd voor ambulante of onlineregistraties. 

2. Stel een registratietype in dat de van toepassing zijnde werkruimtelayout, analyse en rapportage en 

te gebruiken apparaten en apparaatprofielen bevat. 

De wizard Recording Type (Registratietype) is apparaatafhankelijk. Dit betekent dat de wizard varieert 

afhankelijk van het type Nox-registratieapparaat dat wordt geconfigureerd. De belangrijkste stappen zijn 

echter altijd hetzelfde: 
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Navigeer vanuit de Noxturnal taakbalk naar Devices > Recording Types (Apparaten > Registratietypen)…  

 

De wizard Recording Type (Registratietype) wordt geopend. 

  

  

Hier kunt u een New (Nieuw) registratietype of een New Based On (Nieuw op basis van) één van de 

beschikbare registratietypen aanmaken en bij eerder zelf aangemaakte registratietypen kiezen voor Edit 

(Bewerken) of Remove (Verwijderen). In dit voorbeeld zullen we een nieuw registratietype aanmaken voor de 

Nox T3-recorder.  

Selecteer het registratietype Nox T3 (ambulatory) (ambulant) uit de hieronder weergegeven keuzelijst. 
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De volgende stap is het instellen van een toepasselijk registratietype. In de volgende wizard kunt u uw 

registratietype instellen.  
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Voer de Recording Type Name (Registratietypenaam) en de Description (Beschrijving) van het registratietype 

in. Kies de gewenste Workspace Layout (Werkruimtelayout), Analysis (Analyse) en Report (Rapportage). U 

kunt ook hulpapparaten toevoegen. Kies bijvoorbeeld de Nonin 3150 (onder Device Types (Apparatuurtypen)) 

en klik op Add>> (Toevoegen). 

 

Het is ook mogelijk om een relevant apparaatprofiel voor dit registratietype rechtstreeks te kiezen in de wizard 

Recording Type (Registratietype), zie hieronder.  
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U kunt ook aangepaste apparaatprofielen aanmaken. Volg hiervoor de instructies in de paragraaf 

Apparaatprofielen. Zodra u een apparaatprofiel hebt aangemaakt, wordt dit weergegeven in de keuzelijst in de 

registratietypewizard. 

Als u uw registratietype hebt ingesteld, klikt u op OK en komt uw aangepaste registratietype beschikbaar voor 

configuratie.  

Apparaatprofielen 

 
 NB: De apparaatprofielenwizards verschillen per Nox-registratieapparaat. 

De apparaatprofielen worden aangemaakt voor alle standaardregistraties die u met Nox-apparaten kunt 

uitvoeren. U kunt ze gebruiken om het apparaatconfiguratieproces te vereenvoudigen. 

Vanuit de Noxturnal taakbalk navigeert u naar Devices > Device Profiles… (Apparaten > Apparaatprofielen) 
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In de wizard Device Profiles (Apparaatprofielen) wordt een lijst weergegeven van de beschikbare 

apparaatprofielen voor de Nox-registratieapparaten en het Nox-toegangspunt. 

 

Om een aangepast apparaatprofiel aan te maken, selecteert u New (Nieuw) of New Based On (Nieuw op basis 

van). U moet dan selecteren voor welk registratieapparaat de template is bestemd of op welk van de huidige 

apparaatprofielen u uw nieuwe template wilt baseren. In dit voorbeeld zullen we een nieuw apparaatprofiel 

aanmaken voor de Nox T3-recorder. 
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In de wizard Profile Properties (Profieleigenschappen) kunt u het apparaatprofiel instellen. Voer de naam in 

(en desgewenst een beschrijving).  

  

Klik op Next (Volgende) om verder te gaan naar de volgende stap. 
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In de het onderstaande dialoogvenster kunt u de kanaalconfiguratie voor het apparaat instellen. De 

apparaatconfiguratiedialoog is apparaatafhankelijk. Dit betekent dat de wizard varieert afhankelijk van het 

type Nox-apparaat dat wordt gebruikt. Als u de kanaalconfiguratie hebt ingesteld, klikt u op Next (Volgende). 

   

De laatste stap in de configuratie van een Nox-registratieapparaat is het definiëren van het gebruikte 

batterijtype. Selecteer het van toepassing zijnde batterijtype en klik op Finish (Voltooien). 
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Het apparaatprofiel dat u hebt aangemaakt wordt in de lijst met apparaatprofielen weergegeven en is 

beschikbaar voor configuratie.  

Een ambulante registratie van een Nox-registratieapparaat downloaden 

 

 NB: Als het downloaden om de een of andere reden deels mislukt, kan dat 

leiden tot onduidelijke registratieresultaten. De gebruiker zal worden 

gewaarschuwd als dit gebeurt en moet dan beslissen of de geregistreerde 

gegevens al dan niet volledig zijn. Het is mogelijk om de gegevens nogmaals te 

downloaden vanaf het apparaat. 

 NB: De gedownloade registratie wordt pas van het apparaat verwijderd als het 

apparaat  voor een andere registratie wordt geconfigureerd. 

Om geregistreerde gegevens van een Nox-registratieapparaat naar de computer  te downloaden, moet u 

ervoor zorgen dat Noxturnal draait en vervolgens een apparaat op een USB-poort van de computer aansluiten. 

Noxturnal detecteert automatisch het apparaat en geeft de informatie ervan weer op de Recording Page 

(Registratiepagina). Detectie kan 2 tot 4 seconden duren. 

Klik op de knop Download Recording (Registratie downloaden) op de Recording Page (Registratiepagina) en 

Noxturnal zal beginnen met het downloaden van de registratie vanaf het apparaat naar de computer. Een 

dialoogvenster met de downloadvoortgang wordt weergegeven. Deze toont de stappen van het 

downloadproces. De gegevens worden eerst gedownload en vervolgens wordt het standaardanalyseprotocol 

uitgevoerd en als het apparaat is geconfigureerd voor het registreren van audio, dan start de audiodownload.  
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Na het downloaden wordt de gebruiker op de hoogte gesteld en kan deze beginnen te werken met de gehele 

registratie. 

Het downloaden van registraties vindt altijd plaats naar de standaard gegevensopslaglocatie. Het is mogelijk 

om de standaard gegevensopslaglocatie te wijzigen op het automatiseringstabblad in het dialoogvenster met 

beschikbare tools (Tools >  Settings > General (Tools > Instellingen > Algemeen)). Na het downloaden worden 

registraties automatisch toegevoegd aan de registratiebibliotheek en kunnen ze op elk moment worden 

bestudeerd door naar de registratiebibliotheek te gaan en deze te openen. Zie voor meer informatie de 

paragraaf De registratiebibliotheek.  
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Instellen van het Nox-slaapsysteem voor onlineregistraties  

Netwerkoverzicht onlinesysteem 

Houd onderstaande aanbevolen systeeminstellingen aan voor een stabiele werking van de online 

functionaliteit voor het Nox-slaapsysteem.  

● Het wordt aanbevolen om voor elk onlinesysteem een andere computer te gebruiken. Het is echter 

mogelijk om meer dan één systeem te draaien op één computer. Zie de paragraaf Minimum 

systeemeisen voor details.  

● Gebruik een apart Local Area Network (LAN) voor elk Nox C1-toegangspunt en een computer waar de 

Noxturnal-software op draait. 

● Gebruik een apart Nox C1-toegangspunt voor elke te gebruiken Nox A1-recorder. 

De onderstaande tabel beschrijft de opstelling van de controlekamer waar de computer met Nocturnal 

geïnstalleerd is.  

Controlekamer 

Item Aansluiting 

PC 
Met een netwerkkabel aangesloten op 

hetzelfde netwerk als het Nox C1-toegangspunt. 

Noxturnal Geïnstalleerd op een pc 

De onderstaande tabel beschrijft de opstelling van een patiëntkamer waar de patiënt slaapt tijdens een 

slaaponderzoek. 

Patiëntkamer 

Itemnaam Beschrijving Functie Opstelling/aansluiting 

Nox C1-
toegangspunt 

Bluetooth-
toegangspunt met 
analoge en seriële 
inputs en ingebouwde 
lichtsensor en 
differentiële 
druksensor. 

 Gegevensoverdracht 
ontvangen van Nox A1 
via een Bluetooth-
verbinding en via 
ethernet naar 
Noxturnal 
doorgestuurd. 

 Opdrachten 
ontvangen van 
Noxturnal via ethernet 
en door middel van 
een Bluetooth-
verbinding naar Nox 
A1 doorgestuurd. 

 Gegevensoverdracht 
ontvangen van 
hulpapparaten 
verbonden met 
analoge en/of seriële 
inputs en via ethernet 

Die zich in de 
patiëntkamer 
bevinden. 
Aangesloten op 
hetzelfde LAN als de 
pc waarop de 
Noxturnal-software 
draait. 
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naar Noxturnal 
doorgestuurd. 

Nox A1-recorders 
en de van 
toepassing zijnde 
sensoren 

Registratieapparaat 
dat voor verschillende 
typen 
slaaponderzoeken kan 
worden 
geconfigureerd. 

Registreert fysiologische 
signalen van ingebouwde 
en aangebrachte 
sensoren. 

Aangesloten op de 
patiënt in de 
patiëntkamer. 

Medische 
hulpapparaten 

Elk medisch 
hulpapparaat dat 
overeenkomt met de 
inputkanaalspecificatie
s van het Nox C1-
toegangspunt. 
Medische 
hulpapparaten die 
worden ondersteund 
door het systeem voor 
verbinding met de Nox 
A1-recorders via 
Bluetooth-koppeling 

Afhankelijk van het 
gebruikte hulpapparaat 

De relevante 
aansluitkabel 
aangesloten op de 
analoge/seriële/USB-
input op het Nox C1-
toegangspunt. Via 
Bluetooth-koppeling 
naar de Nox A1-
recorders 

Noxturnal-app Android-app  

Kan worden gebruikt voor 
het verbinden met 
onlinekamers, het 
beoordelen van signalen 
en het uitvoeren van 
biokalibratie en 
impedantiecontrole. Kan 
ook voor het starten en 
stoppen van registraties 
worden gebruikt. 

De app instellen op 
onlinemodus en 
verbinding maken met 
de betreffende 
onlinekamer 

De afbeelding hieronder toont een overzicht van de online opstelling van het Nox-slaapsysteem.  
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Het Nox C1-toegangspunt wordt bestuurd door de Noxturnal-software.  

Voor verdere instructies over het Nox C1-toegangspunt en de Nox A1-recorders, zie de Nox C1-handleiding en 

de Nox A1/A1s-handleiding.  

Zie de paragraaf "Compatibele apparaten" voor de typen ethernetapparatuur en -schakelaars die goedgekeurd 

zijn voor het Nox-slaapsysteem. 
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Onlinesysteemconfiguratie  

In dit hoofdstuk wordt het instellen van het Nox-slaapsyteem voor onlineconfiguratie beschreven. Overtuig u 

er eerst van dat u alle benodigde apparaten en accessoires hebt geïnstalleerd, zoals het Nox C1-toegangspunt, 

ethernetkabels en dergelijke. Zie de handleiding van de Nox C1 voor meer informatie over het instellen van uw 

netwerk, waaronder het Nox C1-toegangspunt.  

Voor het instellen van het Nox-slaapsysteem voor onlineregistratie moet u de volgende stappen voor zover 

toepasbaar uitvoeren: 

1. Instellen onlinekamers 

2. Configuratie nieuwe sensoren 

3. Instellen apparaatprofielen 

4. Instellen registratietypen 

Deze stappen worden hieronder genoemd. Door deze stappen te volgen, kunt u beginnen met uw 

onlineregistratie en vervolgens beginnen met het werken met de signalen in Noxturnal. 

Onlinekamer 

Het instellen van een onlinekamer maakt deel uit van de instelling van Noxturnal voor onlineregistraties. De 

onlinekamer betreft een verzameling apparaten die u normaal gesproken in een kamer bij elkaar houdt. Dit 

kunnen bijvoorbeeld alle apparaten zijn die u in een speciaal voor slaaponderzoeken ingerichte 

ziekenhuiskamer bij de hand hebt.  

Om een nieuwe kamer toe te voegen, selecteert u Devices > Online Rooms… (Apparaten > Onlinekamers…) 

vanuit de Noxturnal taakbalk. Het dialoogvenster Rooms (Kamers) verschijnt dan. 
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Van hieruit kunt u een nieuwe kamer toevoegen of een bestaande bewerken. Om een nieuwe kamer toe te 

voegen, klikt u op Add Room (Kamer toevoegen). In het onderstaande dialoogvenster kunt u de nieuwe kamer 

een naam geven door te klikken op het potloodpictogram en apparaten toevoegen aan uw kamer door te 

klikken op Add Devices (Apparaten toevoegen). 

 

 

In de wizard Add Devices (Apparaten toevoegen) kunt u apparaten aan uw kamer toevoegen. Om een 

apparaat toe te voegen, selecteert u het relevante apparaat uit de lijst Device Types (Apparaattypen) en klikt u 

op Add >> (Toevoegen) of dubbelklikt u op het apparaat in de lijst. U kunt scannen op aangesloten IP-

apparaten op uw netwerk door te klikken op Scan for IP Devices (Scan op IP-apparaten). 
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Als u een Nox A1-recorder toevoegt, moet u het relevante Nox C1-toegangspunt selecteren dat in de kamer 

wordt gebruikt en klikken op Scan voor uw Nox A1-recorder of handmatig het serienummer van de A1 

invoeren. Vergeet niet om voor deze stap uw A1-recorder in te schakelen. Selecteer uw recorder uit de lijst en 

klik op Next (Volgende).  
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Als u een selectie van apparaten hebt toegevoegd aan de verzameling van beschikbare apparaten, kunt u de 

apparaten selecteren die u wilt toevoegen aan uw Onlinekamer.  

 

Om apparaten te selecteren voor toevoeging aan uw kamer klikt u op het betreffende apparaat. Geselecteerde 

apparaten worden gemarkeerd door een blauw kader. Als u alle gewenste apparaten hebt geselecteerd, klikt u 

op Add to Room (Aan kamer toevoegen), waarna uw kamer met deze selectie aan apparaten wordt uitgebreid. 

 

Nu hebt u de configuratie van de onlinekamer voltooid. Als u nog meer kamers wilt toevoegen voert u 

bovenstaande stappen nogmaals uit.  
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Configuratie van nieuwe sensoren 

Als u nieuwe sensorconfiguraties wilt aanmaken, bijvoorbeeld voor gebruik met het Nox C1-toegangspunt, 

kunt u dat doen door te navigeren naar Devices > Sensors… (Apparaten > Sensoren) vanuit de Noxturnal 

taakbalk. 

   

Vanuit de wizard Manage Sensors (Sensoren beheren) kunt u een nieuwe sensor aanmaken en bestaande 

sensoren bewerken/verwijderen. Om een nieuwe patiëntsensor of hulpapparaatsensor aan te maken, klikt u 

op New (Nieuw). Patiëntsensoren zijn sensoren die zijn verbonden met de Nox A1-, T3, of T3s-recorders en de 

patiënt. Hulpapparaatsensoren zijn verbonden met het Nox C1-toegangspunt en een hulpapparaat.  

 

U kunt selecteren of een nieuwe patiëntsensor of een hulpapparaatsensor moet worden aangemaakt. Vul de 

relevante velden in en klik op OK om de sensorconfiguratie op te slaan. 

Apparaatprofielen voor onlineapparaten 

Voor de Nox-apparaten die voor onlineregistraties worden gebruikt kunt u apparaatprofielen instellen. De 

apparaatprofielen bevatten de kanaalconfiguratie van het apparaat. Noxturnal biedt een reeks standaard 
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apparaatprofielen aan en u kunt ook gemakkelijk nieuwe apparaatprofielen instellen. Zie voor instructies over 

het zelf aanmaken van apparaatprofielen de paragraaf Apparaatprofielen. 

Registratietypen voor onlineapparaten 

De laatste stap is het instellen van registratietypen. Dit is een lijst van de typen registraties die u online 

registreert in uw kliniek. Elk registratietype is een verzameling beschikbare online-apparaattypen die samen 

worden gegroepeerd. Bijvoorbeeld: De Standaard PSG met Nox C1 omvat een Nox C1-toegangspunt, een Nox 

A1-recorder, een Nonin 3150-oximeter en een videocamera. Zie voor instructies over het instellen van een 

nieuw registratietype de paragraaf Registratietypen. 

Starten van een onlineregistratie 

Als u de bovenstaande stappen voor het instellen van uw onlineconfiguratie hebt voltooid, kan een 

onlineregistratie worden gestart. Vanuit de registratiepagina kunt u een onlineregistratie starten binnen de 

kamer die u hebt ingesteld. Om de registratie te starten, dubbelklikt u op het kamerpictogram of klikt u op 

Configure Recording (Registratie configureren). 

 

Hierdoor wordt de wizard Start Online Recording (Onlineregistratie starten) weergegeven. Met deze wizard 

kunt u: 

● Het uit te voeren registratietype selecteren uit de keuzelijst. 

● De selecteerbare apparaten zijn afhankelijk van het gekozen registratietype. Alle in de 

onlinekamer beschikbare apparaten zijn zichtbaar, maar apparaten die geen deel uitmaken van 

het registratietype zijn grijs gemaakt. U kunt de uitgeschakelde apparaten in de registratie 

opnemen door het aanvinken van de desbetreffende hokjes in de lijst van apparaten. 

● Selecteer Device Profile (Apparaatprofiel) voor een aantal apparaten, bijvoorbeeld de Nox A1 en 

de Nox C1. 
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Als u eenmaal uw registratietype en de juiste apparaten samen met hun apparaatprofielen hebt geselecteerd, 

kunt u op Next (Volgende) klikken om naar de patiëntinformatie te gaan. De laatste stap is het starten van de 

registratie en dat doet u door te klikken op Start Recording (Registratie starten) of op Standby binnen de 

wizard Patient Information (Patiëntinformatie).  

Registratie starten: 

Vervolgens ziet u uw geselecteerde werkruimtelayout, waarbij een statusvenster de status toont van de 

registratie die aan het starten is. Ten slotte ziet u in realtime de geregistreerde signalen verschijnen en kunt u 

ermee beginnen te werken. 

Standby-modus: 

De standby-modus opent uw geselecteerde werkruimte met een statusvenster dat aangeeft dat u in de 

standby-modus bent. Hier kunt u verbinding maken met de onlinekamer voor het voorbereiden, evalueren en 

assisteren bij het aansluiten van de patiënt en vervolgens de registratie starten met behulp van de Noxturnal-

app of Start Recording (Registratie starten) zoals beschreven in de voorgaande stap. 
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Wanneer de gebruiker de Noxturnal-app heeft verbonden met de onlinekamer, worden de live-signalen die 

verschijnen NIET in de registratie opgeslagen. Dit is alleen een preview, zoals ook door de preview-status 

wordt aangegeven. De signaalregistratie begint zodra de gebruiker op Start Recording (Registratie starten) 

tikt/klikt in de Noxturnal-app of in de Noxturnal-software. 

 

Door te klikken op de rode REC-knop bovenin in het scherm, kan de gebruiker ook op elk moment na de start 

van de registratie naar de standby-modus gaan als hij de registratie gedurende een bepaalde periode wil 

pauzeren. 

 

Door op de REC-knop te klikken, krijgt u de optie om naar standby-modus te gaan, de registratie te stoppen of 

te annuleren en door te gaan met de registratie. 

 

 

Een impedantiecontrole en biokalibratie uitvoeren 

Voor een uitgebreidere controle van de elektro-encefalografie (EEG) elektrodes is het mogelijk een 

impedantiecontrole uit te voeren. Na het starten van de registratie klikt u op de "Ohm" knop.  
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De gekleurde cirkels geven de kwaliteit van de verbinding weer. Groen is Goed (<5 kΩ), geel is Matig (5 kΩ tot 

20 kΩ) en rood is Slecht (>20 kΩ).  

De volgende stap is het uitvoeren van een biokalibratie. Ga hiervoor naar de Scoring Button 

(Scoretoekenningsknop) en selecteer Bio Calibration (Biokalibratie). 

 

De geselecteerde taak wordt uitgelicht en het te verwachten resultaat onderaan het tabblad vermeld. Als het 

voorval eenmaal een score is toegekend, verschijnt het voorval ook op het signaalblad.  
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Nox C1-configuratie 

Het Nox C1-toegangspunt is voorzien van 12 analoge kanalen die geschikt zijn voor het opvangen van DC-

signalen van hulpapparaten. De kanalen worden opgevangen op 6 poorten, gelabeld DC IN 1 tot en met 12 

bovenop het apparaat. Elke analoge poort is geschikt voor 2 kanalen. Hulpapparaten kunnen worden 

aangesloten op de analoge ingangen van de Nox C1. Het voltagebereik maakt communicatiesignalen van -5 V 

tot +5 V  mogelijk. Zie de handleiding van de Nox C1 voor meer informatie over het Nox C1-toegangspunt.  

Netwerkconfiguratie van het Nox C1-toegangspunt 

De standaard fabrieksconfiguratie van het Nox C1-toegangspunt wordt in de onderstaande tabel  

weergegeven. De Nox C1-netwerkconfiguratie kan met Noxturnal worden beheerd. 

Nox C1-netwerkconfiguratie Details 

DHCP-server DHCP-pool: 192.168.101.64 - 192.168.101.127 

Statisch IP-adres 192.168.101.10 

Universele Plug and Play (UPnP) 

ontdekking 

Netwerkprotocol dat mogelijk maakt dat de Nox C1 op een 

netwerk wordt gedetecteerd  
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Om de netwerkconfiguratie van de Nox C1 te beheren, kunt u een Onlinekamer openen die is geconfigureerd 

(Devices > Online Rooms…, (Apparaten > Onlinekamers)) en de Nox C1 selecteren binnen de kamer en dan op 

Edit Device (Apparaat bewerken) klikken. In het onderstaande dialoogvenster kunt u zien hoe u de 

netwerkconfiguratie van de Nox C1 kunt wijzigen.  

 

Firmware van het Nox C1-toegangspunt upgraden 

Als er een nieuwe versie van de firmware van het Nox C1-toegangspunt beschikbaar is voor het verbonden 

apparaat, laat Noxturnal dit de gebruiker weten door een melding hierover weer te geven wanneer de 

gebruiker een onlineregistratie start. 
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De gebruiker kan via het tabblad Devices (Apparaten) in de menubalk toegang krijgen tot de de firmware-

upgrade. 

Devices >> Online Rooms… (Apparaten >> Onlinekamers)  

 

Selecteer het Nox C1-toegangspunt en klik op Edit Device (Apparaat bewerken). 

 

Selecteer in het venster met de eigenschappen van het apparaat Upgrade Firmware (Firmware upgraden). 
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De voortgang van de firmware-upgrade wordt met een statusbalk weergegeven. Wanneer de upgrade klaar is, 

ziet u dit: 

 

Activeren van de Nox DC-kanaallicentie 

Standaard zijn de DC-kanalen op het Nox C1-toegangspunt vergrendeld. Om de DC-kanalen te kunnen 

gebruiken op de Nox C1 heeft u een geactiveerde Nox DC-kanaallicentie nodig. Raadpleeg voor meer 

informatie hierover Nox Medical of diens vertegenwoordigers. 

De licentie wordt geactiveerd door op Set License (Licentie instellen) in het dialoogvenster Device Properties 

(Apparaateigenschappen) te klikken dat hieronder wordt weergegeven, en de instructies op de pagina te 

volgen. 
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Integratie van videoapparaten voor onlineregistraties  

Noxturnal ondersteunt onlinevideoregistratie. Om de door Noxturnal geboden digitale video-ondersteuning te 

gebruiken bij een onlineregistratie moet u uw systeem zodanig configureren dat er een videosysteem in kan 

worden opgenomen. 

Een videoapparaat kan aan uw onlinesysteemconfiguratie worden toegevoegd en de installatie kan voor 

toekomstig gebruik worden opgeslagen. Om een videoapparaat te configureren met uw systeem, moet u: 

1. zorgen dat er video-codecs op uw computer zijn geïnstalleerd 

2. zorgen dat het videoapparaat is aangesloten op hetzelfde netwerk als het Nox C1-toegangspunt en de 

computer waarop Noxturnal draait  

3. Een onlinekamer instellen, inclusief het videoapparaat 

4. Een registratietype instellen, inclusief het videoapparaat en een gedefinieerd videoprofiel  

5. De onlinekamer selecteren en een onlineregistratie starten vanuit de Noxturnal-registratiepagina 

Een onlinekamer met een videoapparaat instellen 

VIDEO-CODECS 

Noxturnal's ondersteuning voor video is gebaseerd op de video-codecs die op uw computersysteem zijn 

geïnstalleerd. Deze video-codecs bestaan uit gespecialiseerde software die de compressie en decompressie 

van digitale video mogelijk maakt. Noxturnal installeert geen codecs, maar op de meeste computersystemen 

zijn wel enige codecs geïnstalleerd. Voor het gebruiken van video met uw Nox-slaapsysteem moeten er codecs 

op uw computersysteem geïnstalleerd zijn. Noxturnal geeft u dan toegang tot de functies die door deze codecs 

worden ondersteund. U kunt het K-Lite Codec Pack downloaden vanaf de Nox Medical ondersteuningssite:  

http://support.noxmedical.com/hc/en-us/articles/207882176  

INTEGRATIE VAN EEN VIDEOCAMERA 

Voor het opzetten van een onlineregistratie inclusief videoapparaat volgt u de onderstaande stappen. 
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1. Opzetten van een Onlinekamer in Noxturnal, zoals uitgelegd in het hoofdstuk Onlinekamer (Devices > 

Online Rooms…, (Apparaten > Onlinekamers) vanuit de Noxturnal taakbalk).  

2. Voeg een videoapparaat toe aan uw onlinekamer door te klikken op Add Devices (Apparaten 

toevoegen) en Video Device (Videoapparaat) te kiezen in de lijst Device Types (Apparaattypen).  

       

3. U ziet het dialoogvenster met de apparaateigenschappen zoals hieronder weergegeven. Klik op de 

toepasselijke optie, afhankelijk van het gebruikte videoapparaat en klik op Next (Volgende). 
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Om uw IP-camera in te stellen, klikt u op Find… (Vinden). Noxturnal scant dan uw netwerk en detecteert de op 

uw netwerk aangesloten videocamera's, mits UPnP (netwerkprotocol waarmee een IP-camera kan worden 

ontdekt op een netwerk) erop is ingeschakeld. Noxturnal biedt standaard verbindingsopties voor bepaalde IP-

camera's (Axis, D-Link-camera's, Vivotek en Hikvision). Zorg ervoor dat bij het kiezen van de in Noxturnal 

beschikbare verbindingsreeks, de juiste verbindingsreeks (URL) wordt gekozen voor de registratie die u uitvoert, 

afhankelijk van of er alleen video moet worden geregistreerd of zowel video als audio.  

Als uw camera niet automatisch door Noxturnal wordt gedetecteerd als u Find… (Vinden) gebruikt, dan kunt u 

altijd uw camera handmatig toevoegen door de betreffende verbindingsreeks (URL) en het IP-adres van de 

camera in te voeren in het veld File or URL (Bestand of URL). 
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Als u een videoapparaat hebt dat niet door de bovenstaande standaard verbindingsopties wordt ondersteund, 

kunt u altijd handmatig nieuwe verbindingsreeksen (URLs) aanmaken om ze zo voor gebruik in de toekomst 

toegankelijk te maken in Noxturnal. Om dat te doen, bladert u naar Tools > Settings > Advanced (Tools > 

Instellingen > Geavanceerd) en selecteert u de Default Settings (Standaardinstellingen). Open de map Video 

Profiles (Videoprofielen) en open het Excel-werkblad IPCameras (IP-camera's). U kunt aan de bestaande lijst 

van verbindingsreeksen een nieuwe verbindingsreeks toevoegen voor uw videoapparaat, die vervolgens 

beschikbaar wordt voor gebruik binnen Noxturnal.  

Als u de gebruikers- en wachtwoordinformatie voor uw camera hebt ingevoerd, kunt u klikken op Start 

Preview (Preview starten) om te controleren of uw camera correct is ingesteld en werkt met Noxturnal. Als 

een vertraging wordt waargenomen tijdens de preview, kan een vertragingsinput worden toegevoegd om het 

afspelen van de video tijdens de analyse te corrigeren. Klik op Next (Volgende) om de camera een unieke 

naam te geven en klik vervolgens op Finish (Voltooien).  
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Nu hebt u het videoapparaat aan uw onlinekamer toegevoegd.  

Een registratietype met een videoapparaat instellen 

Noxturnal voorziet in standaard registratietypen voor onlineregistraties inclusief een videoapparaat. U kunt 

een van de standaard registratietypen selecteren en direct starten met een onlineregistratie inclusief een 

videoapparaat. U kunt ook een aangepast registratietype instellen en een Windows Mediaprofiel definiëren 

voor gebruik met Noxturnal bij registratie en compressie van de onlinevideo. Om dat te doen, navigeert u naar 

Devices > Recording Types... (Apparaten > Registratietypes) vanuit de Noxturnal taakbalk. In de wizard 

Recording Types (Registratietypen) selecteert u New (Nieuw) en Online uit de keuzelijst Recording Type 

(Registratietype). 
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In de wizard Online Recording Type (Onlineregistratietype) kunt u zowel uw videoapparaat als andere 

apparaten toevoegen. U kunt het videoprofiel dat u wilt gebruiken selecteren in de keuzelijst, zie de afbeelding 

hieronder.  
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Noxturnal biedt een aantal standaard videoprofielen, maar u kunt ook aangepaste profielen aanmaken en 

gebruiken in Noxturnal. Zie voor verdere informatie en instructies over hoe u dat moet doen de Nox Medical 

ondersteuningssite, Windows Media Profiles in Noxturnal. 

Nu hebt u uw onlinesysteem zo geconfigureerd dat een videoapparaat er deel van uitmaakt en kunt u een 

onlineregistratie starten vanuit de Noxturnal-pagina Recording (Registratie) door te dubbelklikken op de 

kamer, of te klikken op Configure Recording (Registratie configureren). 
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Werken met registraties in Noxturnal  

Registratieresultatenpagina  

Na het downloaden vanaf een registratieapparaat of het openen van een bestaande registratie in Noxturnal, 

wordt de pagina Recording Results (Registratieresultaten) weergegeven. Deze pagina bevat een overzicht van 

de meest gangbare analyseparameters en de geregistreerde signalen. De resultaatpagina wordt automatisch 

geüpdatet wanneer veranderingen worden doorgevoerd in de bestaande scoretoekenning of als de 

automatische analyse wordt uitgevoerd. Wanneer er slaapstadia beschikbaar zijn, zoals voor registraties 

uitgevoerd met de Nox A1-recorders, dan ziet u grafieken en gegevens met die informatie. Voor de Nox T3-

recorders ziet u alleen parameters die beschikbaar zijn bij die apparaten. 

 

Commando's resultatenpagina 

De registratieresultatenpagina heeft knoppen voor de volgende acties: 

● View Report (Rapport bekijken): deze optie maakt het standaardrapport voor de registratie aan, het 

rapport dat gedefinieerd is binnen het registratietype (zie voor meer informatie de paragraaf 

Registratietypen). 

● Print Report (Rapport afdrukken): deze optie drukt het standaardrapport af. 

● Recording Status (Registratiestatus): deze optie maakt het instellen van de status van registraties 

mogelijk. Gedownloade registraties hebben altijd de status New (Nieuw). Als een registratie om de 

een of andere reden is mislukt, kan de status worden ingesteld op Invalid (Ongeldig). Als de 

registratie is gediagnosticeerd, kan de status worden ingesteld op Scored (Gescoord). Als de 

registratie en de scoretoekenning zijn beoordeeld, kan de status worden ingesteld op Reviewed 

(Beoordeeld). Als de registratie is geïnterpreteerd, kan de status worden ingesteld op Interpreted 

(Geïnterpreteerd). Als een registratie is gediagnosticeerd en geaccepteerd, kan de status worden 

ingesteld op Done (Gereed). 
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Patiëntinformatie 

Het paneel Information (Informatie) toont informatie over de geregistreerde patiënt. Bewerk de registratie-
eigenschappen en de patiëntinformatie door op het patiëntpictogram te klikken of door te drukken op de 
sneltoets Ctrl+I. 

 

 

Slaapparameters 

Het paneel Sleep Parameters (Slaapparameters) toont een ringdiagram met verschillende slaapstadia indien 
de slaapstadium-voorvallen van scores zijn voorzien. 

 

 

● Total Sleep Time (Totale slaapduur) is de tijd die de patiënt heeft geslapen (gebaseerd op 

Hypnogram). 

● Wanneer Total Sleep Time (Totale slaapduur) niet beschikbaar is, wordt de Est. Total Sleep Time 

(Geschatte totale slaapduur) (idem aan de AASM-term Monitoringsduur) gebruikt als parameter. Dat 

is de tijd die de patiënt liggend doorbrengt tijdens de registratie. 

● De slaapefficiëntie varieert van 0 tot 100%, waarbij 0% betekent dat de patiënt de gehele nacht 

wakker was en 100% betekent dat hij/zij gedurende de gehele nacht heeft geslapen. Als 

slaapscoretoekenning niet beschikbaar is, gebruikt de software bewegingsperioden om deze 

parameter in te schatten. 

Ademhalingsindices 

Het paneel Respiratory Indices (Ademhalingsindices) toont de belangrijkste analyseparameters en hun relatie 

tot de ernst. De AHI, de Apnea Hypopnea Index (Apneu-hypopneu-index), is het aantal apneus en hypopneus 

per uur slaap en de Oxygen Desaturation Index (ODI (Zuurstofdesaturatie-index)) is het aantal gescoorde 

zuurstofsaturatiedalingen per uur slaap (standaard automatische analyse scoort alle desaturaties van 3% of 

hoger maar dit kan door de gebruiker worden aangepast). De ernst gaat van Normaal → Mild → Matig → 
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Ernstig en is in overeenstemming met de door de AASM vastgestelde niveaus. Als meer dan één nacht is 

geregistreerd, tonen deze parameters de gemiddelde waarden voor alle nachten. Zie voor meer informatie de 

paragraaf Analyseprotocollen. 

 

Totale signaalkwaliteit en Single Body Source (enkele lichaamsbron)  

De Overall Signal Quality (Totale signaalkwaliteit) wordt bepaald aan de hand van de monitoring van de 
kwaliteit van de volgende signalen: oximeter, luchtstroom, buik- of thoracale ademhalingsinspanningssignalen. 
De laagste signaalkwaliteit voor die signalen wordt getoond als de totale signaalkwaliteit op de 
registratieresultatenpagina en heeft een waarde van 0 tot 100%.  

Het resultaat Single Body Source (Enkele lichaamsbron) geeft aan of de signalen van de oximeter en de RIP-

band van dezelfde persoon komen. Zie voor meer informatie over dit resultaat de paragraaf Single Body 

Source. 

 

Signaaloverzicht en parameters 

Het paneel Signal Overview (Signaaloverzicht) is een top-down-beoordelingstool waarmee registratieresultaten 

op een efficiënte manier kunnen worden beoordeeld en bewerkt. Het overzichtspaneel wordt opgesplitst in 

analyseparameters rechts en het signaaloverzicht links. 
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De analyseparameters tonen een samenvatting van de meest voorkomende analyseparameters voor één 

nacht. Als meer dan één nacht is geregistreerd, dan wordt elke nacht gerepresenteerd binnen zijn eigen panel. 

U kunt ook de te bekijken periode selecteren met het periodemenu in de rechterbenedenhoek van de 

toepassing. Elke parameter is van een kleurcode voorzien op basis van de mate van ernst, variërend van groen 

tot rood (Normaal → Mild → Matig → Ernstig). 

● Arousal Index (Arousal-index) is het aantal arousals per uur tijdens de slaap. 

● Sleep Latency (Slaaplatentie) is de duur in minuten van de analysestarttijd tot de eerste periode van 

gescoorde slaap. 

● REM Latency (REM-latentie) is de duur in minuten van het eerste optreden van slaap tot het eerste 

optreden van REM. 

● De ademhaling wordt door indices weergegeven. Indices zijn een methode om analyseparameters op 

een gestandaardiseerde manier weer te geven. 

o Apnea Hypopnea Index (AHI (apneu-hypopneu-index)) 

o Apnea Index (AI (apneu-index)) 

o Hypopnea Index (HI (hypopneu-index)) 

o De Oxygen Desaturation Index (ODI (Zuurstofdesaturatie-index)) stelt het aantal 

zuurstofdesaturatievoorvallen per uur voor van de Total Sleep Time (Totale slaapduur) of 

anders de Est. Total Sleep Time (geschatte totale slaapduur). 

o Het Snore Percentage (Snurkpercentage) is het percentage slaaptijd doorgebracht in 

snurkepisodes (gemarkeerd als Snore-trains) 

o Average dB (Gemiddelde dB) zijn de gemiddelde dB-niveaus tijdens snurkepisodes. 

● De Signal Quality (Signaalkwaliteit) wordt bepaald aan de hand van de monitoring van de kwaliteit 

van de volgende signalen: SpO2, luchtstroom, buik- of thoracale ademhalingsinspanningssignalen. De 

signaalkwaliteit van die signalen wordt weergegeven van 0-100%. 

Signalen en voorvallen 

De signalen en voorvallen geplot in het signaaloverzichtpanel geven een overzicht van de gehele nacht. 

● Tot de signalen in het overzicht kunnen de volgende behoren: 

o Spectrogram voor het kanaal dat op het scherm wordt weergegeven (rechtsklikken op het 

spectrogram om het kanaal te veranderen)  

o Sleep Stages/Hypnogram (Slaapstadia/hypnogram) toont de slaapstadia gedurende de nacht 

o Arousals toont de arousals gedurende de nacht  

o Beweging 

o Houding 

o Apneus/RIP-fase (fase tussen buik- en thoracale ademhalingsinspanningssignalen) 

o Zuurstofdesaturatie (SpO2) 

o Pols 

o Audiovolume (Snurk-dB)  

o Beenbewegingen (optioneel) 



Handleiding Noxturnal 

   

~ 54 ~ 

● De in het overzicht getoonde voorvallen zijn apneus en hypopneus, zuurstofsaturatiedalingen, 

snurkepisodes en artifacten. 
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De analyseperioden wijzigen 

Als een registratie start voordat alle sensoren zijn bevestigd of als de patiënt de sensoren verwijdert voordat 

de registratie is geëindigd, is het mogelijk om het interval dat wordt geanalyseerd aan te passen door de 

analysestart marker en de analysestop marker te verplaatsen naar de betreffende plaats binnen de 

registratie. Alle analyseparameters worden dienovereenkomstig geüpdatet wanneer deze aanpassingen 

worden gedaan. 

 

Gebruik de synchronisatiemarker om in de registratie te navigeren . Alle signaalbladen zoals de bladen PSG, 

Respiratory (Ademhaling) en Pulse Oximeter (Pulsoximeter) worden dienovereenkomstig gesynchroniseerd. 

Als een interessant voorval te zien is in het overzicht, sleept u de synchronisatiemarker over dat gebied en 

bladert u in het desbetreffende signaalblad om de ruwe signalen te bekijken.  

Voorvalperioden kunnen direct vanuit het paneel Signal Overview (Signaaloverzicht) worden toegevoegd. Om 

een voorvalperiode toe te voegen, verplaatst u de cursor naar het paneel Periods (Perioden) en klikt u met de 

muis. Het menu Event Period (voorvalperiode) zal verschijnen zoals hieronder weergegeven.  

 

Uitsluiting van ongeldige gegevens kan worden uitgevoerd in het paneel Signal Overview (signaaloverzicht). 

Om ongeldige gegevens uit te sluiten van de registratie, verplaatst u de cursor naar één van de signalen, klikt u 
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op de linkermuisknop en selecteert u een gebied door naar links/rechts te slepen. Laat de muisknop los. 

Vervolgens wordt het onderstaande menu weergegeven. De voorvallen die als 'Invalid Data' (Ongeldige 

gegevens) zijn gemarkeerd, worden van de rapportberekeningen uitgesloten. 

 

 

Eenheden instellen 

Om het eenhedensysteem te wijzigen dat wordt gebruikt voor het voorstellen van eenheden zoals lengte en 
gewicht, navigeert u naar Tools > Settings… (Tools > Instellingen) vanuit de Noxturnal taakbalk. Op de pagina 
General (Algemeen) zoekt u de keuzelijst System Units (Systeemeenheden) en selecteert u het betreffende te 
bewerken veld. 
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Signalen bekijken 

Menuknop Werkruimte 

Met de Workspace Menu Button (menuknop Werkruimte) kunt u verschillende werkruimtelayouts en 

signaalbladen toepassen om de weergave van uw registraties naar wens te beheren. De werkruimtelayouts 

bevatten een selectie van signaalbladen en signaalbladeigenschappen. Noxturnal biedt een reeks standaard 

werkruimtelayouts en signaalbladen. U kunt ook aangepaste werkruimtelayouts en signaalbladen instellen. U 

kunt alle wijzigingen in uw werkruimtelayout opslaan voor toekomstig gebruik. Dit betekent dat u instellingen 

kunt wijzigen en uw werkomgeving kunt inrichten zoals u dat wilt. 

 

U kunt de menuknop Workspace (Werkruimte) gebruiken voor de bewerking Add Sheet (Blad toevoegen), 

voor het aanmaken van een New Workspace Layout (Nieuwe werkruimtelayout), waarbij u een standaard 

layout als basis gebruikt of zelfs voor Revert Layout (Layout terugzetten) na het maken van wijzigingen. 

 

Om een aangepast signaalblad op te slaan, klikt u met de rechtermuisknop op de signaalbladtab en selecteert 

u Save Sheet Layout As... (Bladlayout opslaan als). Als u het aangepaste signaalblad hebt opgeslagen, kunt u 

altijd kiezen voor Update Saved Layout (Opgeslagen layout updaten) als aanvullende wijzigingen worden 

doorgevoerd. Zie voor meer informatie over signaalbladen de paragraaf Signaalbladen. 
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Signaalbladen 

Een signaalblad toont een of meer signalen in een tabvenster in de werkruimte. Noxturnal wordt geleverd met 

voorgedefinieerde signaalbladen, zoals de bladen Respiratory (ademhaling), PSG en Pulse Oximeter 

(pulsoximeter). 

Om signalen aan een signaalblad toe te voegen of eruit te verwijderen, navigeert u de muis naar het 

taakvenster Signals and Data (Signalen en gegevens) rechts van de werkruimte. Als de cursor boven deze tab 

staat, verschijnt het taakvenster Signals and Data (Signalen en gegevens). Een lijst van alle beschikbare 

signalen wordt in dit taakvenster weergegeven. Een selectiehokje naast het signaal bepaalt of het signaal al 

dan niet in het blad wordt weergegeven. Vink het hokje aan of haal het vinkje weg om het signaal aan het blad 

toe te voegen of eruit te verwijderen. Zie hieronder het tabblad Signals and Data (Signalen en gegevens). 
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Werken met signalen 

 

De navigatiebalk maakt snelle navigatie mogelijk naar elk moment in de registratie. De blauwe lijn geeft 

aan waar in de registratie de gebruiker zich bevindt. Klik op een plaats in de balk om naar dat moment te 

gaan. 

De tijd-as geeft de registratietijd en de tijdperiode in het venster weer. Klik met de rechtermuisknop op 

de tijd-as om het interval in het venster te wijzigen. Rek de tijd-as uit of maak deze smaller met de muis 

om het tijdinterval in het venster te wijzigen. 

De synchronisatiemarker op de tijd-as wordt gebruikt voor het synchroniseren met andere signaalbladen 

en weergaven. De klok aan de rechterzijde van de navigatiebalk toont de tijd van de markerpositie. De 

synchronisatiemarker kan in de tijd worden gesleept en verplaatst. 
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De signaalwaarde-as toont de naam van het bijbehorende geplotte signaal en de schaal van de waarde-

as. De as kan met de muis worden uitgerekt/smaller worden gemaakt. Om de eigenschappen van de 

waarde-as te wijzigen, dubbelklikt u op de as. Er wordt dan een dialoog weergegeven waarmee de 

eigenschappen kunnen worden gewijzigd. 

Signaalplot in een deelvenster. Signalen kunnen op vele manieren worden bijgesteld. Verander de 

grootte van het signaaldeelvenster of verplaats het signaaldeelvenster door de muis te gebruiken. Om de 

eigenschappen van het signaal te wijzigen, dubbelklikt u op het signaal. Er wordt dan een dialoogvenster 

weergegeven waarin de signaaleigenschappen kunnen worden gewijzigd. Voor toegang tot alle acties 

voor een individueel signaalspoor klikt u met de rechtermuisknop op het signaalspoor, waarna het 

volgende menu verschijnt. 

 

Toetsenbordnavigatie 

Navigeer en manipuleer het signaalblad door de volgende shortcuttoetsen in te drukken: 
 
Navigatie: 

● Pijl-rechts = standaard - halve pagina vooruitspringen, configureerbaar door de gebruiker 

● Pijl-links = standaard - halve pagina terugspringen, configureerbaar door de gebruiker 

● Ctrl + pijl-rechts= standaard - hele pagina vooruitspringen, configureerbaar door de gebruiker 

● Ctrl + pijl-links= standaard - hele pagina terugspringen, configureerbaar door de gebruiker 

● PageDown-toets = pagina vooruitspringen 

● PageUp-toets = pagina terugspringen 

● Home-toets = Start van de registratie 

● End-toets = Einde van de registratie 

● Shift + pijl-rechts = Vergroot de aangegeven tijd in het venster 

● Shift + linkertoets = Verlaagt de aangegeven tijd in het venster 

● Shift + Ctrl + linkertoets = Spring naar de vorige datasessie 

● Shift + Ctrl + rechtertoets = Spring naar de volgende datasessie 
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● - toets = Uitzoomen uit de selectie 

● + toets = Inzoomen in de selectie 

● Muiswieltje = Vooruit-/achteruitbladeren 

● Muiswieltje + Ctrl-toets = Omhoog- en omlaagbladeren 

Actief signaal: 

● Shift + Up = Signaalschaling verhogen 

● Shift + Down = Signaalschaling verlagen 

● Ctrl + Up = Signaal omhoogschuiven 

● Ctrl + Down = Signaal omlaagschuiven 

● Shift + Enter = Toon actief signaal in nieuw blad 

● Shift + Delete = Verwijder actief signaal uit blad 

● Up-toets = Selecteer bovenstaand signaal 

● Down-toets = Selecteer onderstaand signaal 

● Ctrl + F = Voorvallen zoeken 

● F9 = Signaal automatisch schalen 

Signaalblad: 

● Spatie = Afspelen/Pauzeren registratie terugspelen 

● Ctrl + W = Signalen automatisch schalen 

● Ctrl + A = Signalen schikken 

Voorvallen: 

● Tab = Volgende voorval, indien u naar het volgende zoekresultaat zoekt 

● Shift + Tab = Vorige voorval, indien u naar het vorige zoekresultaat zoekt 

● Delete = Geselecteerde voorvallen verwijderen of voorvallen verwijderen die de selectie overlappen 

● Return = Deselecteren van alle voorvallen 

● Esc = Verwijderen van alle selecties 

Werken met voorvallen 

Voorvallen worden gebruikt voor het identificeren van interessegebieden in een signaal. Een voorval heeft een 

start- en een stoptijd en een type dat wordt gebruikt om het te classificeren. Voorvallen kunnen handmatig 

worden toegevoegd aan een signaal of door de automatische analyse van een score worden voorzien om 

interessegebieden te markeren. Voorvallen kunnen worden veranderd of verwijderd. 

Scoretoekenning van een voorval 

Om een voorval te scoren, gaat u naar een blad dat signalen bevat; lokaliseer een gebied op een signaal van 

interesse. 

 Markeer met de linkermuisknop een gebied om het voorval van een score te voorzien. 

 Druk op de sneltoets voor dat voorval. Sneltoetsen kunnen worden toegewezen aan een voorvaltype vanuit 

Setting > Event Types & Groups > Edit > Behavior (Instellingen > Voorvaltypen & groepen > Bewerken > 

Gedrag). 
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Een andere methode voor het toekennen van een score aan een voorval is het markeren van een gebied met 

de linkermuisknop, zoals eerder, maar dan door met de rechtermuisknop op het gebied te klikken en een 

voorval in de lijst te selecteren. 

Scoretoekenning met een enkele klik 

Noxturnal biedt de optie om een score toe te kennen met één klik: Single Click Scoring. Om scoren met één 

enkele klik te activeren, klikt u op het pictogram in de Noxturnal taakbalk.  

 

Binnen het betreffende signaalblad kent u handmatig een score toe aan een voorval op het desbetreffende 

signaalspoor. Zie voor instructies over het handmatig toekennen van een score aan een voorval de 

bovenstaande paragraaf Scoretoekenning aan een voorval. Als u aan het eerste voorval een score hebt 

toegekend, kunt u met de functie scoren met één klik doorgaan met het toekennen van een score aan 

hetzelfde voorvaltype met slechts één muisklik terwijl u door de registratie bladert. 

Een voorval verwijderen 

Er zijn verscheidene manieren om bestaande voorvallen te verwijderen: 

● Selecteer een voorval door er met de linkermuisknop op te klikken en vervolgens op de toets Delete 

(Verwijderen) te drukken. 

● Klik met de rechtermuisknop op een voorval en selecteer Remove Event (Voorval verwijderen). 

● Selecteer met de muis een gebied dat kruist met de voorvallen om die te verwijderen en druk op de 

toets Delete (Verwijderen). 
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Een voorval verplaatsen 

Om een voorval te verplaatsen, selecteert u het voorval door de linkermuisknop ingedrukt te houden en het 

voorval dan naar de gewenste plaats te slepen. Voorvallen kunnen tussen signalen worden gesleept en naar 

een andere tijdsperiode. 

De grootte van een voorval wijzigen 

Om de grootte van een voorval te veranderen, verplaatst u de muiscursor over de linker- of rechterbegrenzing 

van een voorval. De cursor moet veranderen in een pictogram van een pijl die naar rechts en links wijst. Zodra 

het pictogram in een pijl is veranderd, klikt u met de linkermuisknop en sleept u het voorval naar de gewenste 

duur. 

Door voorvallen navigeren 

Er zijn verscheidene manieren om door gescoorde voorvallen te navigeren in de registratie: 

● Spring tussen voorvallen met toegekende scores op een signaal heen en weer door op het signaal te 

klikken en de Tab-toets in te drukken, zodat u naar het volgende voorval in de tijd springt. Om naar 

het vorige voorval in de tijd te springen drukt u op de Shift- + Tab-toetsen. 

● In de rechterbovenhoek van de werkruimte ziet u een zoektekstvak dat u kunt gebruiken om te 

zoeken naar voorvallen waaraan een score is toegekend. Door op het tekstvak te klikken verschijnt 

een vervolgkeuzelijst van alle voorvaltypen waaraan scores zijn toegekend. Om te zoeken naar 

voorvallen van een bepaald type klikt u op het voorvaltype in de lijst. Dit toont het volgende voorval 

in de tijd met dat type. Klik op de navigatieknoppen in de keuzelijst om door de voorvallen te 

navigeren. 

● Selecteer View > Event Overview (Bekijken > Voorvaloverzicht) uit de Noxturnal taakbalk om een 

overzichtvenster weer te geven dat alle voorvallen die in de registratie zijn gescoord toont in een plot. 

Om naar een specifiek voorval te navigeren, klikt u erop in het overzichtsplot. 
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Voorvallen die artefacten overlappen  

Voorvallen die overlappen met artefacten worden geteld. Voorvallen die ongeldige gegevens overlappen, 

worden echter niet meegeteld en worden vervaagd getekend. Zie onderstaande afbeelding:  

 

 

Twee Desats (desaturaties) waarvan één met overlappend artefact, beide op dezelfde manier getekend 

 

Twee Desats (desaturaties), één wordt vervaagd getekend omdat deze niet wordt geteld 
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Analyseprotocollen 

Een Analyseprotocol is een groep detectors die op de registratie kunnen worden uitgevoerd om verscheidene 
voorvallen te detecteren en te markeren binnen de geregistreerde signalen. De beschikbare 
analyseprotocollen, inclusief de standaardprotocollen, worden genoemd onder het menu Analysis (Analyse). 
Om een analyseprotocol uit te voeren op de registratie selecteert u de betreffende analyse uit het menu 
Analysis (Analyse) en klikt erop. 

Noxturnal biedt een reeks standaard analyseprotocollen, en u kunt ook een nieuw analyseprotocol met 

aangepaste instellingen en/of -detectors aanmaken. Om een analyseprotocol op maat op te zetten, gaat u 

naar Analysis > Manage Protocols (Analyse > Protocols beheren) vanuit de Noxturnal taakbalk. U kunt een 

bestaand protocol bewerken en hernoemen of een nieuwe op basis van een bestaand protocol aanmaken.  

      

In dit voorbeeld zullen we een nieuw analyseprotocol aanmaken. Selecteer New (Nieuw) in het dialoogvenster 

Manage Analysis (Analyse beheren). Een nieuw analyseprotocol-blad wordt geopend, waarin het nieuwe 

protocol kan worden gedefinieerd. Een protocol is een verzameling detectoren en de functie van een detector 

is het lokaliseren van interessegebieden binnen een signaal en het toekennen van scores aan de gebieden met 

voorvallen.   
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Om een detector aan het protocol toe te voegen, kiest u een detector uit de lijst met detectoren en selecteert 

u Add Detector >> General Properties (Detector toevoegen >> Algemene eigenschappen); vervolgens kan het 

invoersignaal worden bewerkt.   

Als u uw analyseprotocol instelt, klikt u op Save and Close (Opslaan en afsluiten). Het protocol wordt aan de 

lijst van beschikbare analyses toegevoegd.  

Werken met scoretoekenningen 

Een scoretoekenning is een verzameling voorvallen waaraan scores worden toegekend op basis van signalen in 

de registratie. De acties voor het werken met scoretoekenningen vindt u in de Scoring Button 

(Scoretoekenningsknop) in de Noxturnal taakbalk. De acties voor het werken met scoretoekenningen worden 

in de onderstaande paragrafen vermeld.  

  

Als u een Analysis protocol (Analyseprotocol) hebt opgenomen in het registratietype dat voor de registratie is 

geconfigureerd, dan gebruikt Noxturnal bij het downloaden vanuit een Nox-registratieapparaat automatisch 

het standaardanalyseprotocol voor het analyseren van de registratie. Voor onlineonderzoeken moet u de 

registratie afsluiten als deze is voltooid en indien geopend vanuit de registratiebibliotheek analyseert de 

gedefinieerde standaardanalyse de gegevens. Het automatisch analyseren van de gegevens genereert een 

nieuwe scoretoekenning met de naam Untitled Scoring (Titelloze scoretoekenning), zie bovenstaande 

schermafbeelding. In de Scoring Button (Scoretoekenningsknop) ziet u altijd de geselecteerde 

scoretoekenning die voor het rapporteren en registreren van overzichtsfuncties wordt gebruikt. U kunt 

gemakkelijk nieuwe scores toekennen door gebruik te maken van de functies van de Scoring Button 
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(Scoretoekenningsknop), bijvoorbeeld als u wijzigingen doorvoert in de automatische scoretoekenning kunt u 

ze gemakkelijk opslaan als nieuwe scoretoekenning, met de van toepassing zijnde naam. 

      

Vanuit de Scoring Button (Scoretoekenningsknop) kunt u ook met Add Event Period (Voorvalperiode 

toevoegen) of Add Note (Notitie toevoegen) een voorvalperiode of notitie aan de registratie toevoegen. 

Nieuwe scoretoekenning 

Bij gebruik van apparaten die een EEG registreren, kunt u gebruikmaken van de slaapstadiëringsfuncties van 
Noxturnal. Noxturnal biedt een automatische slaapstadiëring bij het systeem die helpt bij het handmatig 
toekennen van scores.  Het is ook mogelijk handmatig slaapstadiëring uit te voeren zonder eerst gebruik te 
maken van de automatische slaapstadiëring. 
Voor het uitvoeren van een handmatige slaapstadiëring klikt u op de Scoring Button (Scoretoekenningsknop) 
en selecteert u New Scoring (Nieuwe scoretoekenning).  
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Daarna kunt u, om de slaapstadiëring te starten, de actie Start Sleep Staging (Slaapstadiëring starten) kiezen in 

het menu in de Scoring Button (Scoretoekenningsknop). De nummertoetsen op uw toetsenbord worden 

gebruikt voor de standaard slaapstadiëringhotkeys. U kunt de scoretoekenningshotkeys veranderen zoals 

hieronder wordt uitgelegd. 

Een scoretoekenning selecteren 

Meerdere scoretoekenningen kunnen in verband worden gebracht met één enkele registratie. Alle 

beschikbare scoretoekenningen worden in het scoretoekenningspaneel vermeld. Selecteer de actieve 

scoretoekenning door erop te klikken. 

Scoretoekenning opslaan 

Sla de actieve scoretoekenning op door te klikken op de optie Save Scoring (Scoretoekenning opslaan). De 

gebruiker wordt gevraagd om een naam voor de opgeslagen scoretoekenning. De opgeslagen scoretoekenning 

wordt toegevoegd aan de lijst met scoretoekenningen. 

Scoretoekenning wissen 

Als een scoretoekenning actief is, zal deze actie haar wissen. Als de actieve scoretoekenning lokale wijzigingen 

heeft, wordt de gebruiker gevraagd of hij zijn lokale wijzigingen wil opslaan. 

          Geselecteerde scoretoekenning verwijderen 

Een opgeslagen scoretoekenning kan worden verwijderd door haar te selecteren in de scoretoekenning en te 

klikken op de optie Delete Selected Scoring (Geselecteerde scoretoekenning verwijderen). Er wordt een 

prompt weergegeven die vraagt of het OK is om de scoretoekenning te verwijderen. 
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Scoretoekenning toetsenbordsneltoetsen 

Een sneltoets wordt gebruikt om voorvallen snel te scoren. Sneltoetsen kunnen worden toegewezen aan een 

voorvaltype vanuit Setting > Event Types & Groups > Edit > Behavior (Instellingen > Voorvaltypen & groepen 

> Bewerken > Gedrag). 

De algemene regel is dat voorvallen eigenlijk slechts één toetsenbordteken als sneltoets mogen hebben, maar 

een combinatie van Ctrl, Shift en Alt plus een toetsenbordteken wordt wel ondersteund. 

Noxturnal-rapporten 

 

 NB: De rapportresultaten staan vast en worden niet geüpdate als de analyse van 

de registratie verandert. 

 NB: Als wijzigingen worden doorgevoerd in de analyse, kan een ander rapport 

worden gegenereerd of kan het bestaande rapport worden ververst. 

Noxturnal voorziet in een reeks standaardrapporten die toegankelijk zijn door te klikken op het menu Reports 

(Rapporten) vanuit de Noxturnal taakbalk.  

Rapporten genereren 

Een rapport kan worden gegenereerd door op de knop View Report (Rapport bekijken) te klikken op de 

registratieresultatenpagina of door een rapport te kiezen in het menu Reports (Rapporten) in de Noxturnal 

taakbalk. 

Als u een rapport in het rapportsysteem hebt gegenereerd, kunt u het rapport gemakkelijk wijzigen door 

gebruik te maken van de knop Edit (Bewerken) die zichtbaar is in de taakbalk bij het bekijken van rapporten. 

 

De knop Edit (Bewerken) activeert de bewerkingsmodus waarmee u het rapport kunt bewerken op dezelfde 

manier als wanneer u gebruik zou maken van Microsoft Word®. Alle wijzigingen die u doorvoert, zijn 

onmiddellijk voor u zichtbaar. U kunt ook nieuwe indices toevoegen en zelfs voorgedefinieerde 

rapportonderdelen als u een onderzoek interpreteert. Om de bewerkingsmodus te stoppen drukt u opnieuw 

op de knop Edit (Bewerken). Wijzigingen die worden doorgevoerd in de bewerkingsmodus worden niet als 

onderdeel van de rapporttemplate opgeslagen. 

Rapporten aanpassen 

Noxturnal voorziet in een krachtig rapport-op-maatsysteem dat op Microsoft Word® lijkende mogelijkheden 

bevat. Rapporten in Noxturnal kunnen gemakkelijk aan uw wensen worden aangepast. Voor het maken van 

een aangepast rapporttemplate volgt u de onderstaande stappen. 

1. Selecteer vanuit de Noxturnal taakbalk Reports > Manage Rapporten… (Rapporten > Rapporten 

beheren). 

2. In het dialoogvenster Manage Reports (Rapporten beheren) selecteert u één van de opties Edit 

(Bewerken), New (Nieuw) of New Based On (Nieuw op basis van), afhankelijk van uw voorkeuren. 
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3. In dit voorbeeld maken we een nieuw aangepast rapport aan op basis van het standaard PSG-rapport. 

Selecteer het PSG-rapport in de lijst van beschikbare rapporten en klik op New Based On (Nieuw op 

basis van). 

4. U ziet het volgende dialoogvenster waarin u het nieuwe rapporttemplate een naam kunt geven. 

Vervolgens selecteert u Create (Aanmaken). 

 
5. Er wordt een nieuw blad geopend met het standaard gekozen rapport. In dit venster kunt u het 

bewerken. Aan de rechterkant van het scherm ziet u een verzameling Fields (Velden) en Report Parts 

(Rapportonderdelen) die u voor uw rapport kunt gebruiken. Zie voor meer informatie over 

rapportonderdelen en velden de onderstaande paragraaf Rapportonderdelen en rapportvelden.  
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NB: In het rapporttemplate kunt u over de velden (-) bewegen met de muis om de details van de parameters 

te zien. Zie onderstaande afbeelding. 

 

RAPPORTONDERDELEN EN RAPPORTVELDEN 

Elk rapportonderdeel vertegenwoordigt een deel van uw rapport, zoals oximetrie-saturatie, PLM-details, enz. 

U kunt rapportonderdelen en -velden in Noxturnal aanmaken of onderdelen van standaardrapporten opslaan 

voor gebruik bij het aanmaken van volledig nieuwe rapporten. 

EEN NIEUW RAPPORTONDERDEEL AANMAKEN 

U kunt nieuwe rapportonderdelen aanmaken en opslaan voor later gebruik. Om dat te doen, selecteert u het 

desbetreffende rapportonderdeel in de rapporttemplate (of een aangepaste tekst/tabel) en sleept deze naar 

de lijst met Report Parts (Rapportonderdelen). Geef het rapportonderdeel een naam en selecteer de 
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categorie. Het nieuwe rapportonderdeel dat u hebt aangemaakt, zal aan de lijst van rapportonderdelen 

worden toegevoegd. 
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EEN NIEUW RAPPORTVELD AANMAKEN 

U kunt nieuwe rapportvelden aanmaken en opslaan voor later gebruik. Om dat te doen, volgt u de 

onderstaande stappen. 

1. In dit voorbeeld zullen we het standaard in Noxturnal beschikbare veld Desat Drop ≥ 4% Count 

(Desatuaratiedaling ≥ 4% telling) als basis gebruiken voor ons aangepaste veld. Selecteer Desat Drop ≥ 

4% Count (Desaturatiedaling ≥ 4% telling) en klik op New Based On (Nieuw op basis van). 

2. In de dialoog Edit Report Field (Rapportveld bewerken) geeft u het nieuwe veld een naam en bewerkt 

u de eigenschappen van het nieuwe veld zoals vereist. 
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In dit voorbeeld zullen we de desaturatiedaling veranderen in ≥ 3 en het nieuwe veld een beschrijvende naam 

geven, Desat Drop ≥ 3% Count (Desaturatiedaling ≥ 3% telling). Als de condities moeten worden gewijzigd, 

klikt u op Conditions (Condities) om alle beschikbare condities te zien.  
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RAPPORTONDERDELEN EN -VELDEN AAN RAPPORTEN TOEVOEGEN 

Om rapportonderdelen en -velden aan uw rapport toe te voegen, verplaatst u de cursor naar de 

voorkeurslocatie in het rapport en dubbelklikt u op het gewenste rapportonderdeel in de lijst aan de 

rechterkant. Een andere manier om een rapportonderdeel en -veld aan een rapport toe te voegen, is om het 

gewenste rapportonderdeel/-veld in uw rapport te slepen en in uw rapport te plaatsen. 

KOPTEKST EN VOETTEKST VAN EEN RAPPORT 

Om de koptekst en voettekst van het rapport aan te passen, volgt u de onderstaande stappen. 

1. Vanuit de Noxturnal taakbalk selecteert u Tools > Settings > User & Company (Tools > 

Instellingen > Gebruiker en Bedrijf) en u ziet de volgende wizard waar u gebruikers- en 

bedrijfsinformatie kunt invullen.  

  

Vul de bovenstaande velden in met alle van toepassing zijnde informatie. U kunt de informatie 

ingevoerd in uw rapport invoegen met gebruikmaking van de overeenkomstige rapportvelden.  

 

2. Om de informatie in te voegen in de koptekst/voettekst van uw rapport plaatst u de cursor 

binnen het bovenste gedeelte van het rapport, klikt u met de rechtermuisknop en selecteert u de 

optie Edit Header/Footer (Koptekst/voettekst bewerken). 
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3. Voeg de relevante velden uit de lijst met beschikbare velden toe aan het koptekstgedeelte. 

4. Om een logo toe te voegen aan uw rapportkoptekst, klikt u op Format > Insert Image… (Opmaak 

> Afbeelding Invoegen) zoals hieronder wordt getoond. 

      
 

5. Om paginanummering toe te voegen aan uw rapport, gaat u naar het einde van de 

rapportpagina, klikt u met de rechtermuisknop en selecteert u Edit Footer (Voettekst bewerken). 

Klik met de rechtermuisknop binnen het voettekstgebied en selecteer Insert > Page Number 

(Invoegen > Paginanummer). 

Als u klaar bent met het instellen van uw rapporttemplate selecteert u Save (Opslaan). Uw rapport wordt 

toegevoegd aan de lijst met rapporten die beschikbaar is vanuit de Noxturnal taakbalk. 

Rapporten exporteren 

Om een rapport te exporteren, klikt u op Export (Exporteren) vanuit de rapporttaakbalk. 
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Dit opent een nieuwe dialoog voor het specificeren van het bestandsformaat en de bestandsnaam. Klik op de 

knop Save (Opslaan) als u klaar bent. Het rapport wordt op de schijf opgeslagen in het gespecificeerde 

bestandsformaat. 

Rapporten afdrukken 

Nadat een rapport is gegenereerd, kan de gebruiker het rapport afdrukken. Om een rapport af te drukken, 

selecteert u de optie Print (Afdrukken) in de rapporttaakbalk. 

 

Een dialoog wordt geopend waarin de afdrukmogelijkheden kunnen worden gewijzigd. Klik op de knop Print 

(Afdrukken) om af te drukken. 

De registratiebibliotheek 

De registratiebibliotheek toont en beheert alle registraties die zijn gedownload van de Nox-

registratieapparaten en de onlineonderzoeken. Als registraties worden geopend of gedownload in Noxturnal 

worden ze automatisch toegevoegd aan de registratiebibliotheek. Het is ook mogelijk om licenties te 

verkrijgen waarmee u EDF-bestanden, EDF+-bestanden, Embla-bestanden en Somnostar-bestanden in 

Noxturnal kunt openen. De overeenkomende registraties worden automatisch aan de registratiebibliotheek 

toegevoegd.  

Om een registratie te openen, moet u de registratie in de registratiebibliotheeklijst selecteren en erop 

dubbelklikken. 

Registraties archiveren 

Registraties in de registratiebibliotheek kunnen worden gearchiveerd naar een andere locatie of naar een 
permanente opslag. Om een registratie te archiveren, selecteert u een of meerdere registraties in de 
bibliotheek en klikt u op de knop Archive Recording… (Registratie Archiveren) in het 
registratieinformatiepaneel. Er verschijnt een dialoog die de gebruiker door het archiveringsproces leidt. 
 

Enkele lichaamsbron 

Het algoritme Single Body Source (enkele lichaamsbron) is een algoritme in Noxturnal waarvoor een octrooi is 

aangevraagd. Het algoritme stelt vast of het registratieapparaat en de bijbehorende sensoren tijdens de 

registratieperiode  door dezelfde persoon zijn gedragen. 

Het algoritme leidt tot één van drie resultaten. De resultaten en hun betekenissen worden hieronder 

beschreven. 

● Not analyzed (Niet geanalyseerd): Het algoritme is niet op de registratie uitgevoerd. 

● Approved (Goedgekeurd): Eén lichaamsbron kan voor de registratie worden geverifieerd. 

● Inconclusive (Onzeker): Eén lichaamsbron kan niet voor de registratie worden geverifieerd. 

Verschillende factoren kunnen leiden tot een onzeker resultaat, waaronder de volgende: 
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● De registratie bevat niet de benodigde signalen (een puls-golfvormsignaal van de oximeter en 

minimaal één RIP-signaal). 

● De benodigde signalen hebben ruis of bevatten prominente artefacten. 

● De sensoren waren niet op de persoon aangebracht. 

● De sensoren waren onjuist op de patiënt aangebracht of zijn tijdens de slaap verplaatst. 

● De oximeter en de RIP-banden werden door verschillende personen gedragen. 

● De registratie is te kort (ten minste 15 minuten van gelijktijdig geregistreerde puls-golfvormsignalen 

en RIP-signalen zijn nodig) 

● Het cardiale artefact in de RIP-signalen (veroorzaakt door de emissie van bloed van het hart naar de 

bloedvaten en de daaruit volgende torsobeweging) is te klein. 

Het Single Body Source-algoritme (Enkele lichaamsbron-algoritme) kan ofwel als tool uitgevoerd worden (door 

te klikken op Tools > Single Body Source (Tools > Enkele lichaamsbron)), ofwel als analysedetector worden 

opgenomen in een aangepast analyseprotocol. De tool loopt automatisch nadat registraties van een 

registratieapparaat zijn gedownload. 

Het resultaat van het algoritme wordt voor elke nacht weergegeven op de pagina Recording Results 

(Registratieresultaten) onder Signal Overview (Signaaloverzicht) en is ook beschikbaar als rapportveld dat 

opgenomen kan worden in een aangepast rapport. Het resultaat wordt door middel van één van onderstaande 

symbolen weergegeven: 

 

Niet geanalyseerd 

 

Een grijze cirkel 

Goedgekeurd 

 

Een wit vinkje in een groene 

cirkel 

Onzeker 

 

Een wit vraagteken in een gele 

cirkel 

De automatische berekening van het Single Body Source-algoritme (Enkele lichaamsbron-algoritme) voor 

gedownloade registraties en de weergave van het resultaat kunnen worden in- en uitgeschakeld onder Tools > 

Settings... > Advanced > Single Body Source (Tools > Instellingen > Geavanceerd > Enkele lichaamsbron).  
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Compatibele apparaten 

In de volgende tabel worden de door ethernet ondersteunde apparaten en schakelaars vermeld die 

goedgekeurd zijn voor gebruik met de Nox-slaapbeoordelingssystemen. Noxturnal kan signalen van door 

ethernet ondersteunde apparaten ontvangen, synchroniseren, weergeven en opslaan, als ze met hetzelfde 

netwerk zijn verbonden.  

SCHAKELAARS, IP-CAMERA'S EN MICROFOONS 

Type Catalogusnummer 

Trendnet PoE schakelaar NVT 

Axis T8351, microfoon 3,5 mm NVT 

Axis P3374, internetprotocol-camera NVT 

ONDERSTEUNDE HULPAPPARATEN 

Type Catalogusnummer 

SenTec SDM NVT 

Resmed TxLink NVT 

Resmed AirsenseTM10 NVT 

Resmed S9TM NVT 

Resmed Aircurve NVT 
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Regelgevingsinformatie 

Prestatietests en validatieoverzicht  

Het Nox-slaapbeoordelingssysteem is getest en geverifieerd in verschillende stadia. Dit omvat interne tests, 

verificatie en validatie alsmede externe tests ter waarborging van de productveiligheid, effectiviteit en 

betrouwbaarheid. Het ontwerp is geverifieerd en gevalideerd, inclusief klinische evaluatie, gedurende het 

gehele ontwerpproces, in overeenstemming met de specificaties van de vereisten en het beoogde gebruik.  

Nox Medical is houder van een ISO 13485:2016 (MDSAP) gecertificeerd kwaliteitsbewakingssysteem dat in 

overeenstemming is met de eisen van de Richtlijn inzake medische hulpmiddelen (MDD) - Richtlijn 93/42/EEC 

zoals gewijzigd door Richtlijn 2007/47/EC); Canada -Medical Devices Regulations - deel 1 - SOR 98/282; 

Australië - Therapeutic Goods (Medical Devices) Regulations, 2002, bijlage 3 deel 1 (exclusief Part 1.6) – Full 

Quality Assurance Procedure; Japan – MHLW MO No 169 (2004), zoals gewijzigd door MHLW MO No 60 

(2021); PMD Act en USA – 21 CFR 820, 21 CFR 803, 21 CFR 806, 21 CFR 807 – subdelen A tot D. 

Beschrijving van symbolen en afkortingen  

PG  Polygrafie 

PSG  Polysomnografie 

 
 CE-markering die conformiteit aangeeft met de 

betreffende Europese richtlijnen. 

(01)15694311110255(8012)VVvvr

r(11)JJMMDD(10)JJMMDD 

 Unique Device Identifier (unieke 
apparaatidentificatiecode, UDI); de applicatie-
identificatiecode (01) geeft de 
apparaatidentificatiecode (device identifier (DI)) weer 
("15694311110255"), de applicatie-identificatiecode 
(8012) geeft de softwareversie weer (VVvvrr), de 
applicatie-identificatiecode (11) vertegenwoordigt de 
productiedatum/fabricagedatum ("JJMMDD", waarbij 
"JJ" de laatste twee cijfers van het productiejaar zijn, 
"MM" de productiemaand en "DD" de productiedag), 
en de applicatie-identificatiecode (10) het lot-nummer 
vertegenwoordigt ("ZZZZZZ") 

 

 Unique Device Identifier (unieke apparaatidentificatie 
(UDI)) weergegeven in data-matrixformaat op de 
Noxturnal-CD 

 
 Fabrikantinformatie 

 
 Productiedatum 
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 Batchcode/Partijnummer 

  Catalogusnummer/Referentienummer 
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     Over deze informatie 

Deze handleiding en de bijbehorende vertalingen worden in elektronisch formaat verstrekt in 

overeenstemming met Verordening (EU) nr. 207/2012 van 9 maart 2012 betreffende elektronische instructies 

voor gebruik van medische hulpmiddelen. Ze zijn ook beschikbaar in elektronisch formaat op de website van 

Nox Mecial: www.noxmedical.com. 

Elektronische versies worden verstrekt als PDF-documenten en voor het openen van deze documenten is een 

PDF-reader nodig. Gratis PDF-lezers zijn algemeen beschikbaar voor gebruikers. Zie de relevante systeem- en 

hardwarevereisten voor de gebruikte PDF-reader. 

Een versie op papier kan zonder extra kosten worden aangevraagd door een e-mail te sturen naar 
support@noxmedical.com. De versie op papier wordt binnen 7 kalenderdagen toegestuurd. 
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Bijlage 

Standaard afgeleide signalen  

Noxturnal berekent de standaard afgeleide signalen uit de geregistreerde bronsignalen. Afgeleide signalen zijn 
statistische of directe transformaties van elk willekeurig signaal en worden in de onderstaande tabel 
beschreven. 

Afgeleid signaal Bronsignaal Beschrijving 

Activiteit Gravity X en 
Gravity Y 
(Zwaartekracht 
X en 
zwaartekracht 
Y) 

Indicatie van patiëntactiviteit/bewegingen. Het 
activiteitssignaal wordt berekend uit de ruwe zwaartekracht-
signalen (X- en Y-as) gemeten door de 3-dimensionale 
versnellingsmeter in de Nox-recorders. Het gemeten 
zwaartekracht-signaal wordt gedifferentieerd naar tijd en 
wordt geschaald met de juiste schalingsfactor om het 
afgeleide activiteitssignaal te creëren. 

Audio Volume 
(audiovolume) 
[dB] 

Audio Volume 
(audiovolume) 

Een audiovolume-signaal in logaritmische schaal (met 

eenheden van decibellen) wordt automatisch berekend uit 

het ruwe audiovolume-signaal, die in lineaire schaal is. De 

transformatie waarmee het signaal wordt berekend is V_dB = 

20 log(x/P_0), waar V_dB het volume in decibellen is, P is het 

ruwe audiovolume-signaal (dit is een druksignaal in 

eenheden van Pa) en P_0 is de referentiegeluidsdruk, deze 

heeft een waarde van P_0 = 20 uPa in de Noxturnal-software.  

Calibrated RIP 
Abdomen 
(gekalibreerde 
RIP-buik) 

RIP Abdomen 
(RIP-buik)  

Het gekalibreerde RIP-buiksignaal wordt berekend door het 
schalen van elke waarde van het RIP-buiksignaal met het 
overeenstemmende RIP-K-signaal (afgeleide signaal). Het 
stroomsignaal wordt automatisch aangemaakt als zowel het 
RIP-buiksignaal als het RIP-K-signaal bestaat. 

Calibrated RIP 
Flow 
(gekalibreerde 
RIP-stroom) 

RIP Thorax (RIP-
thorax) 

De gekalibreerde RIP-stroom wordt berekend uit een 
afleiding van de som van het RIP-thoraxsignaal en het 
gekalibreerde RIP-buiksignaal (afgeleid) en heeft de eenheid 
[V/s].  

Calibrated RIP 
Sum 
(gekalibreerde 
RIP-som) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Het gekalibreerde RIP-somsignaal wordt berekend door het 
RIP-thoraxsignaal op te tellen bij het RIP-buiksignaal nadat de 
laatstgenoemde met het RIP-K-signaal  is geschaald.  

Cannula Flow 
(canulestroom) 

Cannula 
Pressure 
(canuledruk) 

Het canulestroomsignaal is een kwalitatief signaal dat 
afgeleid wordt uit het ruwe neuscanuledruksignaal en heeft 
de eenheid [cmH2O]. Het neuscanuledruksignaal is gefilterd 
met een laagdoorlaatfilter op 3 Hz en vervolgens wordt het 
canulestroomsignaal uit een non-lineaire transformatie 
afgeleid.  
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Cannula Snore 
(canule 
snurken) 

Cannula 
Pressure 
(canuledruk) 

Het snurksignaal (Cannula Snore) wordt afgeleid door een 
ruw neuscanuledruksignaal of luchtstroomsignaal te filteren 
met een hoogdoorlaatfilter.  

EMG Frontalis  E1-E3 en E2-E4 Het EMG frontalis-links signaal komt overeen met het 
herbepaalde referentiesignaal E1-E3 en het EMG frontalis-
rechts signaal komt overeen met het herbepaalde 
referentiesignaal E2-E4 

Stroombeperki
ng 

Cannula 
Pressure 
(canuledruk) 

Het stroombeperkingssignaal wordt afgeleid door middel van 
een rekenkundige formule voor het berekenen van de 
vlakheid van een inademing.  

Heart Rate 
(Hartslag) 

ECG Een algoritme voor de detectie van R-golven wordt 
uitgevoerd om elke hartslag in het ECG-signaal  te 
detecteren. De directe hartslag is de wederkerigheid van de 
intervallen tussen opeenvolgende hartslagen. Het 
hartslagssignaal heeft de eenheid [bpm] (beats per minute 
(slagen per minuut)). 

Mask Pressure 
(maskerdruk) 

Raw Pressure 
(Ruwe druk) 

Het maskerdruksignaal wordt berekend op T3- en A1-
apparaten, maar in latere versies van de apparaten wordt het 
maskerdruksignaal berekend in Noxturnal met behulp van 
het Raw Pressure-signaal, als het maskerdrukkanaal is 
opgenomen in het apparaatprofiel voor de registratie. De 
maskerdruk moet identiek zijn aan het signaal voor ruwe 
druk, maar met een ander signaaltype 

Nasal Pressure 
(Nasale druk) 

Raw Pressure 
(Ruwe druk) 

Het neusdruksignaal wordt berekend op T3- en A1-
apparaten, maar in latere versies van de apparaten wordt het 
neusdruksignaal berekend in Noxturnal met behulp van het 
Raw Pressure-signaal, als het maskerdrukkanaal is 
opgenomen in het apparaatprofiel voor de registratie. Het 
ruwe druksignaal wordt gefilterd met een hoogdoorlaatfilter 
om het nasale druksignaal te creëren. 

Houding Gravity X en 
Gravity Y 
(Zwaartekracht 
X en 
zwaartekracht 
Y) 

Een indicatie van de houding van de patiënt om onderscheid 
te maken tussen rechtop, rugligging, buikligging, links of 
rechts. Het Position-signaal wordt afgeleid van Gravity X en 
Gravity Y en geeft de rotatiehoek van het lichaam weer. Het 
varieert van -180° tot 180° en is 0° als de patiënt recht 
omhoog kijkt. 

PTT ECG en Pleth PTT, of pulsdoorgangstijd, wordt gedefinieerd als de tijd 
tussen een R-golf in het ECG en een overeenkomstige stijging 
van 50% van het pleth-signaal (fotoplethysmografiesignaal 
van de oximeter) vanaf het dieptepunt. 

Pulse Wave 
Amplitude 
(pulsgolfamplit
ude) 

Plethysmogram Pulse Waveform Amplitude (PWA) is een signaal die de piek-
tot-piek-waarde van een pulsgolfvorm (het 
fotoplethysmografie-signaal van de oximeter) weergeeft 
door middel van de methode bemonsteren en vasthouden 
voor de duur van de golf. De eenheid is [k]. 
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RIP Sum (RIP-
som) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

De RIP Sum [V] wordt berekend als de som van het RIP-
buiksignaal en het RIP-thoraxsignaal. 

RIP Flow (RIP-
stroom) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

De bandstroom wordt berekent uit een afleiding van de som 
van het RIP-buiksignaal en het RIP-thoraxsignaal en heeft de 
eenheid [V/s]. 

RIP K (RIP-K) RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Voor een nauwkeuriger schatting van de werkelijke 
ademhalingsstroom uit het RIP Abdomen-signaal en het RIP 
Thorax-signaal, moet het RIP-buiksignaal met behulp van een 
kalibratiefactor worden geschaald. Deze kalibratiefactor 
wordt opgeslagen als het afgeleide signaal K. De K wordt 
gevonden door de optimale waarde te vinden waarmee de 
beste correlatie tussen de afgeleide RIP-stroom en een 
referentie-pneumostroom tot stand komt. 

RIP Phase (RIP-
fase) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Het faseverschil tussen de Rip-buikbanden en de RIP-
thoraxbanden. Het fasesignaal varieert van 0° tot 180°. De 
RIP-Phase wordt weergegeven als een signaal dat met de RIP-
buikbanden en de RIP-thoraxbanden is gesynchroniseerd. 

RIP Inductance 
en Fast RIP 
Inductance 
(RIP-inductantie 
en snelle RIP-
inductantie) 

Raw RIP 
counters (Ruwe 
RIP-tellers) 

De RIP-inductantiesignalen worden berekend op A1-
apparaten, maar in latere versies van de apparaten worden 
de RIP-inductantiesignalen berekend in Noxturnal met 
behulp van de Abdomen Raw- en Thorax Raw-signalen (ruwe 
buik- en thoraxsignalen). Er wordt een overdrachtsfunctie 
toegepast op de ruwe signalen, die de resonantiefrequentie 
van de RIP-banden meten, om de inductantie van de banden 
te schatten. Er zijn twee versies van elk RIP-
inductantiesignaal beschikbaar, een bemonsterd op 25 Hz en 
de andere op 200 Hz. 

RIP en Fast RIP 
(Snelle RIP) 

Raw RIP 
counters (Ruwe 
RIP-tellers) 

De RIP-signalen worden berekend op A1- en T3-apparaten, 
maar in latere versies van de apparaten worden de RIP-
signalen berekend in Noxturnal met behulp van de Abdomen 
Raw- en Thorax Raw-signalen (ruwe buik- en thoraxsignalen). 
De ruwe RIP-signalen worden gefilterd met een 
hoogdoorlaatfilter om de RIP-signalen te creëren. Er zijn 
twee versies van elk RIP-signaal beschikbaar, één 
bemonsterd op 25 Hz en de andere op 200 Hz. 

Referentie-EEG EEG-signalen Het referentie-EEG-signaal is een gemiddelde van twee of 
meer EEG-inputsignalen.  

Respiratory 
Rate 
(ademhalingsfr
equentie) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Het ademhalingsfrequentiesignaal wordt afgeleid van het RIP 
Sum-signaal (afgeleid signaal). De ademhalingsfrequentie 
wordt weergegeven als ademhalingen per minuut [rpm]. 
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Set Pressure 
(ingestelde 
druk) 

Mask Pressure 
(maskerdruk) 

Het Set Pressure-signaal wordt afgeleid van het Mask 
Pressure-signaal. Het toont de meest gangbare maskerdruk 
over een 5-seconden-interval. 

TcCO2 [Pa] TcCO2 Het signaal, dat wordt ontvangen van een transcutaan CO2-
apparaat, heeft de eenheid [torr]. Het nieuwe TcCO2-signaal, 
met de eenheid [Pa], wordt berekend met behulp van de 
schalingsfactor 133,3 Pa/torr. 

Automatisch analyseoverzicht  

Er zijn klinische prestatietesten uitgevoerd op de automatische analyse die in Noxturnal plaatsvindt om de 

veiligheid en effectiviteit aan te tonen. De klinische prestatietesten bestonden uit het achteraf analyseren van 

bestaande klinische gegevens uit slaaponderzoeken die al eerder waren verzameld en waaraan handmatig 

scores waren toegekend als onderdeel van normale klinische zorg. Alle scoretoekenners waren gekwalificeerde 

polysomnografie-technologen en hebben de scoretoekenningsrichtlijnen van de AASM (American Academy of 

Sleep Medicine) gevolgd. Het onderzoeksprotocol bestond uit het exporteren van de gerapporteerde 

indices/voorvallen uit de bestaande handmatige scoretoekenning en het vervolgens draaien van de 

automatische analyse in Noxturnal op dezelfde klinische gegevens. De resultaten van de automatische 

scoretoekenning werden geëxporteerd en vergeleken met de resultaten van de handmatig toegekende scores.  

De algemene conclusie van de klinische prestatietesten is dat de automatische analysetools van Noxturnal 

acceptabel zijn als scoretoekenningshulpmiddel in de klinische routine voor het klinische doel zoals 

gespecificeerd voor elke analyse in de tabel hieronder.  

De tabel hieronder beschrijft de automatische analyse in Noxturnal, geeft een kort overzicht van hoe het 

algoritme werkt en welke signalen worden geanalyseerd, beschrijft de criteria die worden gebruikt voor de 

scoretoekenning en welke indices/voorvallen/parameters worden berekend/gescoord. 

 Verder bevat de tabel informatie over de klinische doelen en beperkingen, de klinische aandoeningen die 

worden geanalyseerd, de veiligheidseindpunten gespecificeerd voor elke analyse en het type klinische 

gegevenssets die voor validatie worden gebruikt.  

Naam, doel, indices, voorvallen Klinische aandoening Overzicht 

Bruxisme-analyse  

Het klinische doel is het 
verbeteren van de effectiviteit 
van het toekennen van scores 
aan EMG-gegevens op een 
manier die overeenkomt met 
mogelijke bruxisme-gerelateerde 
voorvallen door mandibulaire 
bewegingen die zijn gemeten 
door een EMG van de 
kauwspieren te labelen voor 
beoordeling en bevestiging door 
een opgeleide zorgverlener.  

Beperkingen: Het is bekend dat 
de analyse het aantal bruxisme-

Kaaksamentrekkingen tijdens de 

slaap. Kaaksamentrekkingen 

(mogelijke bruxisme-gerelateerde 

voorvallen) worden 

geclassificeerd als tonisch 

(aanhoudend dichtklemmende 

samentrekkingen) of fasegewijs 

(herhaaldelijke korte 

samentrekkingen). 

Het algoritme gebruikt een EMG-
signaal van de kauwspieren en het 
activiteitssignaal. Perioden van 
tijdelijk verhoogde 
kauwspieractiviteit worden 
gevonden en gescoord als 
uitbarstingen. Als de gescoorde 
uitbarstingen binnen het patroon 
van tonische of fasegewijze 
bruxisme-episodes passen, 
worden deze als zodanig gescoord 
zoals gedefinieerd door de AASM-
richtlijnen. Standaard worden 
bruxisme-episodes genegeerd als 
deze samenvallen met 
patiëntbeweging, dit wordt 
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voorvallen overschat en 
gemiddeld moeten mogelijk 42% 
van de automatisch gescoorde 
voorvallen handmatig worden 
verwijderd. Voordat een diagnose 
wordt gesteld moeten de 
resultaten van de automatische 
analyse altijd door een 
gecertificeerde technicus of een 
arts worden beoordeeld. 

Gescoorde index: Bruxism 

Episode Index (BEI (Bruxisme-

episodesindex)) - aantal 

bruxisme-episodes per slaapuur 

gekenmerkt door een verhoging 
van het activiteitssignaal. 

Klinische gegevensset: De 
automatische analyse is 
gevalideerd voor klinische 
slaapregistraties van een 
algemene volwassenenpopulatie 
die medische hulp zocht in 
verband met slaapstoornissen. De 
slaapregistraties zijn van een score 
voorzien door een gecertificeerd 
technicus als onderdeel van 
standaard klinisch onderzoek. 

Primair veiligheidseindpunt: De 
analyse werd als veilig bevonden 
als het met 95% betrouwbaarheid 
ten minste 90% van de 
oromandibulaire bewegingen 
detecteerde die een menselijke 
deskundige beschouwde als 
bruxisme-voorvallen. 

Resultaat: De gevoeligheid van de 
analyse was 95,7% (95% BI 93,2% - 
97,4%), specificiteit was 61,0% 
(95% BI 58,9% - 63,0%), PPV was 
34,6% (95% BI 32,0% - 37,3%), 
NPV was 98,5% (95% BI 97,7% - 
99,1%). 

De bruxisme-analyse wordt 

daarom als veilig en effectief 

beschouwd. 

PLM-analyse 

Het klinische doel is het 
verbeteren van de effectiviteit 
van het scoren van voorvallen 
van periodieke 
ledemaatbewegingen.  

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten van de 
automatische analyse altijd door 
een gecertificeerd technicus of 
een arts worden beoordeeld. 

Gescoorde indices:  

Limb Movement Index (LMI 
(ledemaatbewegingsindex)) - 
aantal ledemaatbewegingen per 
slaapuur 

Ledemaatbewegingen tijdens de 
slaap: Perioden, tijdens de slaap, 
die 0,5-10 seconden duren, 
waarbij de spierspanning in een 
ledemaat, meestal gemeten in de 
scheenbeenspier, is verhoogd ten 
opzichte van de nulmeting. 

Periodieke ledemaatbeweging 

tijdens de slaap: Een periode 

tijdens de slaap met minimaal 4 

ledemaatbewegingsvoorvallen 

met intervallen van 5 tot 90 

seconden. 

Het ledemaatbewegingsalgoritme 
maakt gebruik van EMG-signalen 
van het linker- en rechterbeen om 
perioden te identificeren waarin 
de spierspanning is verhoogd. 
Daarnaast wordt het 
activiteitssignaal gebruikt voor het 
detecteren van patiëntactiviteit. 

De PLM-analyse lokaliseert 
voorvallen van hoge spieractiviteit 
of kinetische activiteit en 
identificeert deze als voorvallen 
(van ledemaatbeweging). Deze 
worden vervolgens gebruikt om 
vast te stellen of er PLM-
voorvallen (voorvallen van 
periodieke ledemaatbeweging) 
aanwezig zijn. De analyse volgt de 
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Periodic Limb Movement Index 
(PLMS (periodieke 
ledemaatbewegingsindex)) - 
aantal periodieke 
ledemaatbewegingen per 
slaapuur 

richtlijnen die door de AASM zijn 
uiteengezet. 

Klinische gegevensset: De 
automatische analyse is 
gevalideerd voor klinische 
slaapregistraties van een 
algemene volwassenenpopulatie 
die medische hulp zocht in 
verband met slaapstoornissen. De 
slaapregistraties zijn van een score 
voorzien door een gecertificeerd 
technicus als onderdeel van 
standaard klinisch onderzoek. 

Primair veiligheidseindpunt: De 
analyse werd veilig bevonden op 
basis van de veiligheidshypothese 
dat aan alle onderstaande criteria 
is voldaan voor de PLMS-index. 

• Correlatie tussen klassen 
(ICC, interclass 
correlation) moet groter 
zijn dan 0,61 

• Pearson correlatie-
coëfficiënt (PCC) moet 
gelijk zijn aan of groter 
zijn dan r = 0,65 

• De absolute bias mag niet 
groter zijn dan 5,7 

Resultaat: ICC is 0,98, Pearson 
correlatie-coëfficiënt is 0,94 en 
absolute bias is 0,29 voor de 
periodieke 
ledemaatbewegingsindex 

De PLM-analyse wordt daarom als 
veilig en effectief beschouwd. 

Analyse van de 
ademhalingsstroom 
(gekalibreerde RIP, canule)1  

1) Het klinische doel is het 
verbeteren van de effectiviteit 
van het scoren van apneus, 
hypopneus (door middel van de 
gekalibreerde RIP, canule) en 
desaturatievoorvallen van de 
oximeter.  

Apneus tijdens de slaap: Perioden 
van langer dan 10 seconden 
waarin een patiënt stopt met 
ademhalen. 

Hypopneus tijdens de slaap: 
Perioden van langer dan 10 
seconden waarin een patiënt 
significant minder ademhaalt. 

Zuurstofdesaturatie tijdens de 
slaap: Perioden waarbij de 
zuurstofsaturatie van het 

1) Het Apneu/Hypopneu-
algoritme (AHI-algoritme) 
gebruikt, waar van toepassing, het 
signaal van de 
ademhalingscanulestroom of van 
de gekalibreerde RIP-stroom van 
de ademhaling, afhankelijk van de 
analyse-uitvoering. Het algoritme 
kan gescoorde voorvallen in de 
EEG gebruiken voor het 
toekennen van een score aan 
hypopneus. De gescoorde EEG-

 

1 Inclusief de AHI- en ODI-algoritmes en het Apneuclassificatie-algoritme 
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Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten altijd door een 
gecertificeerd technicus of een 
arts worden beoordeeld. 

Gescoorde indices: 

Apnea Hypopnea Index (AHI 
(apneu hypopneu-index)) - aantal 
apneus en hypopneus per 
slaapuur 

Apnea Index (AI (apneu-index)) - 
aantal apneus per slaapuur 

Hypopnea Index (HI (hypopneu-
index)) - aantal hypopneus per 
slaapuur 

Oxygen Desaturation Index (ODI 
(zuurstofdesaturatie-index)) - 
aantal voorvallen van 
zuurstofdesaturatie per slaapuur. 

2) Het klinische doel is het 
verbeteren van de effectiviteit 
van het classificeren van apneus 
in centrale apneus, gemengde 
apneus of geen van beide.  

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten altijd door een 
gecertificeerd technicus of een 
arts worden beoordeeld. 

Gescoorde indices: 

Central Apnea Index (CAI 
(centrale apneu-index)) - aantal 
centrale apneus en hypopneus 
per slaapuur 

Mixed Apnea Index (MAI 
(gemengde apneu-index)) - aantal 
gemengde apneus per slaapuur 

Central Mixed Apnea Index (CMAI 
(centrale gemengde apneu-
index)) - aantal centrale en 
gemengde apneus per slaapuur 

arteriële bloed van een patiënt 
meer dan 3% onder de nulmeting 
komt. 

Centrale apneus tijdens de slaap: 
Perioden van 10 seconden of 
langer waarbij een patiënt stopt 
met ademen en er geen 
ademhalingsinspanning is. 

Gemengde apneus tijdens de 
slaap: Perioden van 10 seconden 
of langer waarbij een patiënt 
stopt met ademen. 
Ademhalingsinspanning is afwezig 
aan het begin van de periode, 
maar aanwezig aan het einde van 
de periode. 

 

voorvallen zijn arousals tijdens de 
slaap waaraan handmatig scores 
zijn toegekend. Het algoritme 
gebruikt ook een SpO2-signaal, 
gemeten door een oximeter, voor 
het vinden van 
desaturatievoorvallen die worden 
gebruikt voor toekennen van 
scores aan hypopneus. Het 
algoritme kent echter geen scores 
toe aan de desaturatievoorvallen.  

Het AHI-algoritme bepaalt of een 
patiënt normaal ademt, of de 
ademhaling significant is 
verminderd, resulterend in een 
hypopneu of dat een patiënt niet 
ademhaalt, resulterend in een 
apneu. Als de ademhaling 
significant is verminderd, 
controleert het algoritme voor het 
toekennen van een score aan een 
hypopneu of er een arousal is of 
een daling in het zuurstofgehalte 
van het bloed die verband houdt 
met de verminderde ademhaling. 

Het Desaturatie-algoritme (ODI-
algoritme) gebruikt een SpO2-
signaal dat gemeten wordt door 
een oximeter om vast te stellen of 
er een daling van 3% of meer is in 
het zuurstofgehalte van het bloed. 

De analyse volgt de richtlijnen die 
door de AASM zijn uiteengezet. 

2) Het Apnea Classification-
algoritme (apneuclassificatie-
algoritme) gebruikt een 
ademhalingsstroomsignaal en 
daarnaast ook de Respiratory 
Inductance Plethysmography-
signalen (RIP-signalen 
(ademhalingsinductantie-
plethysmografie-signalen)) van de 
buik en de thorax. 

Het Apneuclassificatie-algoritme 
classificeert de apneus die van een 
score zijn voorzien als centraal of 
gemengd als de 
ademhalingsinspanning afwezig is 
tijdens de apneu, of als geen van 
beide. 
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De analyse volgt de richtlijnen die 
door de AASM zijn uiteengezet. 

Klinische gegevensset: De 
automatische analyses zijn 
gevalideerd voor klinische 
slaapregistraties van een 
algemene volwassenenpopulatie 
die medische hulp zocht in 
verband met slaapstoornissen. De 
slaapregistraties werden van een 
score voorzien door een 
gecertificeerd technicus als 
onderdeel van standaard klinisch 
onderzoek.  

Primaire veiligheidseindpunten:  

1) De automatische analyse van de 
ademhalingsstroom werd als veilig 
beschouwd als het met 95% 
betrouwbaarheid patiënten met 
een AHI onder de 5 niet 
classificeerde als een AHI groter of 
gelijk aan 15 of als het met 95% 
betrouwbaarheid patiënten met 
een AHI groter of gelijk aan 15 niet 
classificeerde als een AHI onder de 
5. 

Er zijn twee mede-primaire 
eindpunten voor AHI gebruikt.  

a) Cohen's kappa moet 
gelijk zijn aan of groter 
zijn dan 0,66 en de 
Pearson-correlatie moet 
gelijk zijn aan of groter 
zijn dan r = 0,96 voor de 
canule.  

b) Cohen's kappa van 0,66 
moet binnen het 
betrouwbaarheidsinterval 
van 95% zijn en Pearson-
correlatie moet gelijk zijn 
aan of groter zijn dan r = 
0,72 voor de cRIP. 

Het criterium voor ODI is dat de 
correlatie binnen de klassen 
(Intra-Class Correlation, ICC) gelijk 
is aan of groter is dan 0,93. 

2) De automatische analyse van 
apneuclassificatie werd als veilig 
beschouwd als het voldeed aan de 
acceptatiecriteria van een ICC die 
vergelijkbaar is met dat waarover 
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wordt gerapporteerd in de 
wetenschappelijke literatuur over 
de centrale apneu-index (Central 
Apnea Index, CAI 0,46). 

Resultaat:  

1) De analyse is veilig aangezien 
de kans op onjuiste classificatie 
tussen de verschillende groepen 
minder dan de geaccepteerde 5% 
is.  

a) Cohen's kappa is 0,78 en 
Pearson's r = 0,96 voor de 
canule.  

b) Cohen's kappa is 0,62 
(95% BI 0,56 – 0,66) en 
Pearson's r = 0,79 voor de 
cRIP.  

De ICC voor ODI was 0,95.  

2) De ICC was 0,91 voor de 
centrale apneu-index. 

De respiratoire flowanalyse wordt 
daarom als veilig en effectief 
beschouwd. 

Analyse van slaapstadiëring 

Het klinische doel is het 
verbeteren van de effectiviteit 
van het toekennen van scores 
aan slaapstadia om zo de totale 
slaapduur te schatten.   

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten van de 
automatische analyse altijd door 
een gecertificeerd technicus of 
een arts worden beoordeeld. 

De volgende voorvallen worden 
van scores voorzien: 
slaapstadium W (Wakker), 
stadium N1, stadium N2, stadium 
N3 en stadium R (REM). 

 

Het patroon van slaapstadia 

wordt gebruikt om te analyseren 

hoe iemand slaapt en voor het 

bepalen van afwijkingen in het 

slaapprofiel die kunnen duiden op 

slaapstoornissen. 

Het algoritme maakt gebruik van 
elektro-encefalografiesignalen 
(EEG-signalen), elektro-
oculogramsignalen (EOG-
signalen), het activiteitssignaal en 
een submentaal 
electromyografiesignaal (EMG-
signaal) voor het vooraf scoren 
van slaapstadia volgens de 
handleiding van de AASM.  

Het algoritme wordt toegepast 
met een kunstmatig neuraal 
netwerk. Verschillende functies 
worden berekend aan de hand van 
de EEG, de EOG, het 
activiteitssignaal en de 
submentale EMG en worden in 
het neurale netwerk ingevoerd. 
Deze komt terug met slaapstadia 
in perioden van 30 seconden, om 
zo het handmatig toekennen van 
scores aan slaapstadia te 
simuleren. 

Klinische gegevensset: De 
automatische analyse is 
gevalideerd voor klinische 
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slaapregistraties van een 
algemene volwassenenpopulatie 
die medische hulp zocht in 
verband met slaapstoornissen. De 
slaapregistraties zijn van een score 
voorzien door een gecertificeerd 
technicus als onderdeel van 
standaard klinisch onderzoek. 

Primair veiligheidseindpunt: De 
analyse werd veilig bevonden als 
gemiddeld 60% van de scores van 
de wakkere perioden 
overeenkwamen. Mede-primair 
eindpunt is dat Cohen's kappa-
statistieken gelijk zijn aan of 
groter zijn dan 0,63. 

Resultaat: De Cohen's kappa werd 
berekend als κ = 0,76. De 
gemiddelde overeenstemming 
voor de wakkerheidsscores was 
78,3%. De nauwkeurigheid van het 
voorspellen van slaapstadia 
resulteerde in N1 (54,4%), N2 
(84,4%), N3 (84,8%), Wakker 
(78,3%) en REM (88,2%). De 
slaapstadiëringsanalyse wordt 
daarom als veilig en effectief 
beschouwd. 

Arousal-analyse 

Het klinische doel is het 
verbeteren van de effectiviteit 
van het toekennen van scores 
aan arousals om zo het 
toekennen van scores aan 
hypopneus te verbeteren. 

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten van de 
automatische analyse altijd door 
een gecertificeerd technicus of 
een arts worden beoordeeld. 

De volgende voorvallen worden 
van scores voorzien: Arousals 
gedetecteerd in de EEG-signalen. 

Arousals tijdens de slaap: 

Plotselinge verandering in de 

EEG-frequentie die 3 tot 10 

seconden duurt na 10 seconden 

van stabiele slaap. De 

resulterende arousal-index wordt 

gebruikt voor het detecteren van 

afwijkingen in het slaapprofiel die 

kunnen duiden op 

slaapstoornissen. Er wordt 

rekening gehouden met arousals 

bij het detecteren van hypopneus 

en ze zijn daarom gerelateerd aan 

de apneu-hypopneu-index (AHI). 

Het algoritme maakt gebruik van 
elektro-encefalografiesignalen 
(EEG-signalen) en elektro-
oculogramsignalen (EOG-signalen) 
voor het vooraf scoren van 
arousals volgens de handleiding 
van de AASM.  

Het algoritme wordt toegepast 
met een kunstmatig neuraal 
netwerk. De geregistreerde rauwe 
EEG- en EOG-signalen worden in 
het kunstmatige neurale netwerk 
ingevoerd. Deze komt terug met 
voorvallen waar arousals 
optreden, om zo het handmatig 
toekennen van arousalscores te 
simuleren. 

Primair veiligheidseindpunt: De 
analyse werd veilig en effectief 
bevonden bij een positieve 
overeenstemming (PA) van ten 
minste 60%, een PA ondergrens 
van het 95% 
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betrouwbaarheidsinterval van 
55%, een negatieve 
overeenstemming (NA) van 90% 
en een NA ondergrens van het 
95% betrouwbaarheidsinterval 
van 88% voor perioden gescoord 
als wel of geen arousal bevattend. 

Klinische gegevensset: De 
automatische arousal-analyse is 
gevalideerd voor klinische 
slaapregistraties van een 
algemene volwassenenpopulatie. 
De slaapregistraties zijn van een 
score voorzien door een 
gecertificeerd technicus. 

Resultaten: Totaal werden er 
30.900 perioden gescoord als wel 
of juist geen arousal bevattend. 
De resultaten waren een PA = 
67,67 (95% BI 62,19 - 72,80) en 
een NA = 97,51 (95% BI 96,79 - 
98,16). De arousal-analyse wordt 
daarom als veilig en effectief 
beschouwd. 

Nox BodySleep-analyse 

Het klinische doel is het 
verkrijgen van een nauwkeuriger 
schatting van de slaapduur 
tijdens een thuisslaaponderzoek 
door het juist classificeren van 
wakkerheid in een 
thuisslaaponderzoek. 

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten van de 
automatische analyse altijd door 
een gecertificeerd technicus of 
een arts worden beoordeeld. 

De volgende voorvallen worden 
van scores voorzien: 
slaapstadium Wakker, 
slaapstadium NREM en 
slaapstadium REM. 

De slaapduur wordt gebruikt als 

metriek bij het berekenen van 

AHI (apneu-hypopneu-index) 

tijdens de slaap en kan ook 

worden gebruikt voor het 

beoordelen van slaapduur voor 

het vaststellen van afwijkingen in 

het slaapprofiel die kunnen 

duiden op slaapstoornissen. 

De "Nox BodySleep" is een 
methode van kunstmatige 
intelligentie (AI, artificial 
intelligence) waarmee tijdvakken 
van 30 seconden kunnen worden 
geclassificeerd in de stadia REM-
slaap, NREM-slaap en Wakker. Het 
maakt gebruik van de 
ademhalingsinductantie-
plethysmografie-signalen (RIP-
signalen) en actigrafie voor het 
meten van de invloed van 
verandering in de staat van de 
hersenen op het lichaam. Het 
gebruikt deze signalen voor het 
inschatten van de slaapstadia. 

Klinische gegevensset: Analyse 
achteraf van 
polysomnografiegegevens die zijn 
verzameld met het Nox-
slaapsysteem van patiënten die 
een standaard klinisch 
slaaponderzoek ondergaan 
wegens een vermoedelijke 
slaapstoornis. De slaapregistraties 
zijn van een score voorzien door 
een gecertificeerd technicus als 
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onderdeel van standaard klinisch 
onderzoek. 

Primaire veiligheidseindpunten: 
Het gekozen primaire eindpunt is 
de algehele overeenkomst in het 
classificeren van slaap- en 
waakstadia, die resulteert uit de 
vergelijking tussen handmatige 
scoretoekenning en automatische 
scoretoekenning door de analyse. 
Het eindpunt wordt als succesvol 
beschouwd als de algemene 
overeenstemming van de slaap-
waakclassificatie statistisch 
significant meer dan 76% 
bedraagt. Een secundair 
onderzoekseindpunt is de 
overeenkomst tussen handmatige 
scoretoekenning en automatische 
scoretoekenning zoals beoordeeld 
met Cohen's kappa (κ). Het 
eindpunt wordt beschouwd als 
succesvol als κ > 0,50.  

Resultaten: De algehele 
overeenstemming was 85,6% (95% 
BI 83,4% - 87,6%) en overtrof de 
acceptatiecriteria van 76%. 

De Cohen's kappa van de analyse 
was 0,62 (95% BI 0,58 - 0,66) en 
overtrof het criterium van 0,5. 

De Nox BodySleep Analyse wordt 
daarom als veilig en effectief 
beschouwd. 

SAS-analyse van slaapstadiëring 

Het klinische doel is het 
verbeteren van de effectiviteit 
van het toekennen van scores 
aan slaapstadia om zo de totale 
slaapduur te schatten. 

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten van de 
automatische analyse altijd door 
een gecertificeerd technicus of 
een arts worden beoordeeld. 

De volgende voorvallen worden 
van scores voorzien: 
slaapstadium W (Wakker), 

Het patroon van slaapstadia 

wordt gebruikt om te analyseren 

hoe iemand slaapt en voor het 

bepalen van afwijkingen in het 

slaapprofiel die kunnen duiden op 

slaapstoornissen.  

 

Het algoritme maakt gebruik van 
elektro-encefalografiesignalen 
(EEG-signalen), elektro-
oculogramsignalen (EOG-signalen) 
en frontalis 
electromyografiesignalen (EMG-
signalen) voor het vooraf scoren 
van slaapstadia volgens de 
handleiding van de AASM. 

Het algoritme wordt toegepast 
met een kunstmatig neuraal 
netwerk. De geregistreerde rauwe 
EEG- en EOG-signalen worden in 
het kunstmatige neurale netwerk 
ingevoerd. Deze komt terug met 
slaapstadia in perioden van 30 
seconden, om zo het handmatig 
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stadium N1, stadium N2, stadium 
N3 en stadium R (REM). 

toekennen van scores aan 
slaapstadia te simuleren. 

Klinische gegevensset: De 
automatische analyse is 
gevalideerd voor klinische 
slaapregistraties van een 
algemene volwassenenpopulatie. 
De slaapregistraties zijn van een 
score voorzien door een 
gecertificeerd technicus. 

Primair veiligheidseindpunt: De 
analyse werd veilig bevonden als 
gemiddeld 60% van de scores van 
de wakkere perioden 
overeenkwamen. Mede-primair 
eindpunt is dat Cohen's kappa-
statistieken gelijk zijn aan of 
groter zijn dan 0,63. 

Resultaten: De Cohen's kappa 
werd berekend als κ = 0,69. De 
gemiddelde overeenstemming 
voor de wakkerheidsscores was 
75,8%. De nauwkeurigheid van het 
voorspellen van slaapfasen 
resulteerde in N1 (65,8%), N2 
(85,3%), N3 (80,3%), Wakker 
(75,8%) en REM (86,1%). De SAS-
analyse van slaapstadiëring wordt 
daarom als veilig en effectief 
beschouwd. 

SAS-analyse van arousals 

Het klinische doel is het 
verbeteren van de effectiviteit 
van het toekennen van scores 
aan arousals om zo het 
toekennen van scores aan 
hypopneus te verbeteren. 

Beperkingen: Voordat een 
diagnose wordt gesteld moeten 
de resultaten van de 
automatische analyse altijd door 
een gecertificeerd technicus of 
een arts worden beoordeeld. 

De volgende voorvallen worden 
van scores voorzien: Arousals 
gedetecteerd in de EEG-signalen. 

Arousals tijdens de slaap: 

Plotselinge verandering in de 
EEG-frequentie die 3 tot 10 
seconden duurt na 10 seconden 
van stabiele slaap. De 
resulterende arousal-index wordt 
gebruikt voor het detecteren van 
afwijkingen in het slaapprofiel die 
kunnen duiden op 
slaapstoornissen. Er wordt 
rekening gehouden met arousals 
bij het detecteren van hypopneus 
en ze zijn daarom gerelateerd aan 
de apneu-hypopneu-index (AHI). 

 

Het algoritme maakt gebruik van 
elektro-encefalografiesignalen 
(EEG-signalen), elektro-
oculogramsignalen (EOG-signalen) 
en frontalis 
electromyografiesignalen (EMG-
signalen) voor het vooraf scoren 
van arousals volgens de 
handleiding van de AASM. 

Het algoritme wordt toegepast 
met een kunstmatig neuraal 
netwerk. De geregistreerde rauwe 
EEG- en EOG-signalen worden in 
het kunstmatige neurale netwerk 
ingevoerd. Deze komt terug met 
voorvallen waar arousals 
optreden, om zo het handmatig 
toekennen van arousalscores te 
simuleren. 

Klinische gegevensset: De 
automatische analyse is 
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gevalideerd voor klinische 
slaapregistraties van een 
algemene volwassenenpopulatie. 
De slaapregistraties zijn van een 
score voorzien door een 
gecertificeerd technicus. 

Primair veiligheidseindpunt: De 
analyse werd veilig en effectief 
bevonden bij een positieve 
overeenstemming (PA) van ten 
minste 60%, een PA ondergrens 
van het 95% 
betrouwbaarheidsinterval van 
55%, een negatieve 
overeenstemming (NA) van 90% 
en een NA ondergrens van het 
95% betrouwbaarheidsinterval 
van 88% voor perioden gescoord 
als wel of geen arousal bevattend. 

Resultaten: Totaal werden er 
70.349 perioden gescoord als wel 
of juist geen arousal bevattend. 
De resultaten waren een PA = 
68,10 (95% BI 65,52 - 70,64) en 
een NA = 94,48 (95% BI 93,33 - 
95,46). De SAS-analyse van 
arousals wordt daarom als veilig 
en effectief beschouwd. 

 

 


